
 

Instruction 
Manual 

BioWare® Software 
Type 2812A… 
 

 
2812A_002-312e-02.12 



 

 
 
 
 
 
 
 
 
 
 
 

Instruction 
Manual 
 
 
BioWare® Software 
Type 2812A… 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
2812A_002-312e-02.12 



 



Foreword 

2812A_002-312e-02.12  Page 1 

Foreword 

Thank you for choosing a Kistler quality product 
characterized by technical innovation, precision and long 
life. 
 
Information in this document is subject to change without 
notice. Kistler reserves the right to change or improve its 
products and make changes in the content without 
obligation to notify any person or organization of such 
changes or improvements. 
 
©2004 … 2012 Kistler Group. All rights reserved. Except as 
expressly provided herein, no part of this manual may be 
reproduced for any purpose without the express prior 
written consent of Kistler Group. 
 
 
 
Kistler Group 
Eulachstrasse 22 
8408 Winterthur 
Switzerland 
Tel. +41 52 224 11 11  
Fax +41 52 224 14 14 
info@kistler.com 
www.kistler.com 
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1. Introduction 

Please take the time to thoroughly read this instruction 
manual. It will help you with the installation, maintenance, 
and use of this product. 
 
To the extent permitted by law Kistler does not accept any 
liability if this instruction manual is not followed or 
products other than those listed under Accessories are 
used.  
 
Kistler offers a wide range of products for use in measuring 
technology: 
 Piezoelectric sensors for measuring force, torque, strain, 

pressure, acceleration, shock, vibration and acoustic-
emission 

 Strain gage sensor systems for measuring force and 
torque 

 Piezoresistive pressure sensors and transmitters 
 Signal conditioners, indicators and calibrators 
 Electronic control and monitoring systems as well as 

software for specific measurement applications 
 Data transmission modules (telemetry) 
 
Kistler also develops and produces measuring solutions for 
the application fields engines, vehicles, manufacturing, 
plastics and biomechanics sectors. 
 
Our product and application brochures will provide you 
with an overview of our product range. Detailed data 
sheets are available for almost all products. 
 
If you need additional help beyond what can be found 
either on-line or in this manual, please contact Kistler's 
extensive support organization. 

1.1 Our Thanks 

We thank you for choosing a Kistler quality product. You 
have chosen BioWare, a Biomechanics data acquisition, 
analysis, and presentation system. We think the BioWare  

package will be easy to learn and use, yet powerful enough 
for your requirements. 
 
Please take the time to thoroughly read this operating 
manual. It will help you with the installation, maintenance, 
and use of the BioWare system. There is on-line help 
available by selecting the Help Menu item or pressing the 
F1 key at any time. 
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1.2 Other Kistler Products 

Kistler offers a wide range of measuring instruments and 
complete systems: 
 Quartz, piezoresistive and capacitive transducers for 

measuring force, pressure, acceleration, and strain 
 Associated couplers, charge amplifiers and charge 

calibrators for industrial and laboratory uses 
 Electronic control, display and evaluation equipment 
 
In the field of Biomechanics, Kistler offers an extensive line 
of one-dimensional and three-dimensional force plates, 
accelerometers, load cells, amplifiers, and accessories for 
your applications. 
 
Kistler also designs complete measuring systems for special 
applications, such as in the automotive industry, plastics 
processing industry, and research. Our general catalog will 
provide you with an overview of our products. Detailed 
data sheets are also available for all of our products. 

1.3 License Agreement 

Please refer to the Software License Agreement packet 
containing your BioWare software. This packet thoroughly 
details the Software License Agreement. Kistler Instruments 
retains ownership of BioWare software. This software is 
licensed to you under the following conditions: 
BioWare is protected by the copyright laws that pertain to 
computer software. It is illegal to make copies of the 
software or documentation except for backup purposes. It 
is illegal to give software or documentation to another 
person or institution. The software contains trade secrets 
and in order to protect them you may not decompile, 
reverse engineer, disassemble, or otherwise reduce the 
software to human-perceivable form. You may not modify, 
adapt, translate, rent, lease, or create derivative works 
based upon this software or documentation. 
 
You may permanently transfer the software to another 
user provided you notify Kistler in advance, transfer the 
documentation and all disks, and notify the new user of 
the terms and conditions of the license agreement. 
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1.4 Software Registration 

Please take a moment to fill out the registration form and 
return it to Kistler Instrument Corporation via fax or mail. 
This will allow us to better serve you and notify you of new 
releases. Receiving software updates is contingent on 
returning the registration card, which is located in the 
packet containing the software diskettes. 

1.5 Getting Software Help 

BioWare software takes advantage of the Windows® on-
line help system to offer you quick assistance at the touch 
of a button. To receive immediate help from wherever you 
are in BioWare, press the F1 key and a window will pop up 
with specific advice about the active window or control in 
the software (Fig. 1). 
 

 

Fig. 1: Help is available by pressing the F1 key or from the 
Help menu bar 

 
Help is also accessible by selecting Help Topics from the 
Help menu bar found at the top of the screen. If there is no 
help available for a specific item the default BioWare help 
index is displayed. Begin a search by clicking on the 
"search" tab in the help window. Enter the text for an item 
you want to search (Fig. 2) then press "List Topics". A list 
of topics will be displayed. When you see a specific topic of 
interest, Highlight the topic and click "Display". 
 
 
 
 
 
 
Windows® is a registered trade mark of Microsoft Corporation 
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Fig. 2: The search tab is a quick way to find help on a 
specific topic 

 
If you need additional help beyond what can be found 
either on-line or in this manual, please contact Kistler's 
Biomechanics support organization. 

1.6 Customer Support 

The worldwide Kistler service organization is available for 
any special questions or problems that you may have after 
your careful study of these instructions. Note, refer to 
chapter 1.7 through 1.9 for general policies on customer 
support. Before you call, please be ready to fully explain 
your problem. If you are experiencing a problem with 
BioWare software, please try to duplicate the problem and 
take a snapshot of the screen by pressing the "print 
screen" button. This copies the screen to the clipboard so 
that it can be pasted into a word processing program and 
printed. You can fax or mail this picture to Kistler, or e-mail 
the file to us via Internet. 
 
Outside of North America and Switzerland please contact 
you local Kistler representative or your Kistler subsidiary. 

1.7 Service and Assistance 

The customer is responsible for proper BioWare installation 
and operation. BioWare must be installed as per instruc-
tions provided in chapter 4 and 5.  If modifications to these 
instructions are necessary for a particular purchaser site, 
Kistler recommends the purchaser contact a Kistler repre-
sentative for input and advise regarding these changes. 
 
Installation problems and subsequent system performance 
difficulties can be adverted by timely communication.   
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Often, questions can be answered through email or tele-
phone conversations. The purchaser is encouraged to email 
or call the appropriate Kistler organization in the event of 
such questions. 
 
We welcome comments and suggestions for future fea-
tures and enhancements. Please email all suggestions to 
biomech@kistler.com. 

1.8 Warranty 

Kistler Instrument Corporation warrants BioWare to be free 
from defects in material and workmanship as stated in the 
software license agreement. It is warranted only under 
normal use and service. The period of warranty is twelve 
(12) months from date of shipment. 
When returning items under warranty, said equipment 
shall be returned to Kistler Instrument Corporation prepaid. 
Full details relative to the claim or malfunction shall 
accompany the shipment. No action will be taken until 
these details are received. Please contact Kistler Instrument 
Corporation, if BioWare was purchased in Canada, Mexico 
or the US, or Kistler Instrumente AG Winterthur, if 
BioWare was purchased anywhere else, for a RETURN 
AUTHORIZATION (RA) number before returning goods. 
 
Settlement will be made at Kistler’s discretion, either 
through repair or replacement of the item in question or 
through issuance of full credit. Damage occurring through 
misuse or mishandling, will not be covered by this 
warranty. 
 
This warranty is in lieu of all warranties expressed or 
implied, and of all obligations or liabilities on the part of 
Kistler Instrument Corporation for damages following the 
use or misuse of items supplied. Any unauthorized disas-
sembly or attempt at repair shall void this warranty. 
 
No agent or representative is authorized to assume for the 
Corporation any liability except as set forth within this 
warranty document. 

1.9 Claims 

Claims relating to goods delivered must be made within  
14 days of receipt of goods. After fault determination by 
Kistler, settlement will be made either by the carrier, 
insurer, or Kistler. Means will be through replacement, 
repair or credit. 
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2. Important Information 

Please practice commonsense safety rules at all times. 

2.1 For Your Safety 

 Prior to any installation and repair work or cable 
changes, you must disconnect all power sources from 
the instruments 

 Observe all local safety regulations concerning the 
handling of line-powered electrical and electronic 
equipment 

 When it must be assumed that safe operation is no 
longer possible, the computer, charge amplifier, etc. 
must be taken out of operation and secured against 
unintentional use 

 Whenever opening covers or removing parts, except 
where this can be done by hand, use caution where 
parts under hazardous voltage are exposed 

2.2 Warning 

 Any breakage of the ground conductor inside or outside 
the instruments, or loosening of the ground conductor 
connection may render the instrument dangerous 

 The power plug must be inserted in to a socket with a 
ground connector. The protection must not be nullified 
by an extension line lacking a protective ground con-
nector 

 When changing the signal conditioner fuses, only the 
standard type with the specified amperage rating must 
be used. Use of repaired fuses or short-circuiting the 
fuse holder is expressly forbidden 

2.3 How to Use this Manual 

Whether you are a novice at computers or a long time 
programming expert, you will be pleased to learn how 
quickly and easily you will become familiar with the 
operation of the BioWare software. This manual will take 
you through the installation and setup of the BioWare 

software, and a complete reference to all of the features of 
BioWare. 
If you are eager to begin operation of BioWare we 
recommend Chapter 5, the Quick Start section of this 
manual.  Remember that on-line help is always available by 
pressing the F1 key from anywhere in the software. 
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2.4 Disposal Instructions for Electrical and Electronic Equipment 

 
Do not discard old electronic instruments in municipal 
trash. For disposal at end of life, please return this 
product to an authorized local electronic waste disposal 
service or contact the nearest Kistler Instrument sales 
office for return instructions. 

 

2.5 Software Upgrades and Updates 

Kistler may from time to time supply upgrades or updates 
for embedded software. Such upgrades or updates must 
always be installed.  
 
Kistler declines any liability whatsoever for any direct or 
consequential damage caused by products running on 
embedded software which has not been upgraded or 
updated with the latest software supplied. 
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3. General Description of the System 

BioWare is a general-purpose biomechanics data acquisition 
and display software package suitable for both the clinical 
and research market. It is designed to combine the perfor-
mance of the proven line of Kistler quartz force platforms 
with modern computer technology. BioWare lets you quickly 
setup, record, and display ground reaction forces as well as 
moments, center of pressure parameters and auxiliary 
channels. The system is easily synchronized with a kine-
matics system. 
 
Fig. 3 shows an overview of the entire BioWare system. All 
components have been included with the system (i.e., 
software, cables, junction box, and A/D board). If a com-
puter is included with your system, the BioWare software is 
already installed on it and you can skip the software 
installation portion of this manual. 

Fig. 3: The BioWare splash screen appears for a few sec-
onds when BioWare is first executed 

The BioWare system can consist of many components, each 
specific to the user’s application.  These include: 
 Force plates. One to Eight force plates can be connected 

to the BioWare system 
 Charge amplifier. Either an external (Type 9865) or 

integrated amplifier can be used 
 Computer Boards Inc. DAS-1602 or compatible A/D 

board 
 BioWare software and manual 
 All necessary cabling 
 A computer can be purchased with the software and 

A/D board pre-configured 
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3.1 BioWare® System Requirements 

In order to effectively use BioWare software you will need 
to have a personal computer that meets or exceeds the 
following recommendation. BioWare may not run properly 
if these computer specifications are not met. The overall 
system performance is dependent on the selection of 
hardware. 

 
Recommended Computer Specifications 
 
 Microsoft Windows® 2000 (SP3), or Windows® XP 

operating system  
 Intel Pentium III class processor (500 MHz or higher 

recommended)  
 512 MB of RAM  
 Video Display set to at least 800x600, 256 colors, small 

fonts selected.  
 Disk (free) space required: 125 MB in the target 

directory for data storage and software installation  
 One (1) available slot for the data acquisition board or 

one USB port (ISA, PCI, USB or Type II PCMCIA 
versions of the A/D boards are available).  

 Microsoft compatible mouse  
 Windows® Installer version 1.1 or later (note: on 

Windows® 2000 you may have to install the latest 
updates to get a newer version of the Windows® 
Installer)  

 A color printer is recommended for creating hard copies 
of graphs  

 A graphics card capable of running DirectX 7.0 is 
required for 3D Vector graphics 
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4. Installing BioWare® Software 

This chapter will show you how to install the BioWare 

software, install the data acquisition board, configure the 
data acquisition hardware, as well as hook up the cable 
from the A/D board to the signal conditioner 

4.1 BioWare® Software Installation 

BioWare software consists of one CD-ROM media disk 
containing an automatic installation procedure. If a compu-
ter was purchased as part of the BioWare system, then the 
software is already installed and the enclosed BioWare CD 
should be stored in a safe place as a backup. To install the 
BioWare  software follow the procedure: 
 
 Insert BioWare CD into your CD-ROM drive 
 From the Start menu, choose "Run" 
 In the dialog box, type "D:\KistlerSetup.exe" (without 

the quotes) substituting your CD-ROM drive letter for 
"D" above 

 From the installation splash program, select Install 
BioWare Software 

 Follow the directions of the installation program 
 Additional information can be found in the View Read 

Me and Browse Documentation selections 
 
Proceed to the following steps and install the appropriate 
hardware. 

 
To execute BioWare, open the newly created Kistler   
BioWare sub-group in the Programs extension of the Start 
Menu and click on the "BioWare" icon 
 

 

Many CD–ROM systems will have Autorun enabled 
and the installation splash program will automatically 
run when the CD is inserted into the drive. Continue 
from step 4 above. 

 

4.2 USB Runtime License (HASP Key) – Obsolete 

The runtime license key that was needed to run BioWare 
versions 4.x is no longer required. 
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4.3 Data Acquisition Board Installation 

The data acquisition board should be installed by someone 
who is familiar with installing computer peripherals.   
Installation Note The installation CD contains board 
specific Installation Technical Notes for the various A/D 
boards supplied by Kistler. See these technical notes as well 
as the information below. The procedure to install and 
configure the board is highly dependant on the specific 
board purchased with BioWare. 
 

 

 Make sure to disconnect the power source from 
your computer before opening it 

 Protect the system and A/D board from static 
discharge by touching the computer chassis to 
ground yourself prior to handling the A/D board 

4.3.1 Type 5691A (USB-1616FS) and Type 5695 DAQ (USB-2533) Systems  for 
BioWare  

1. With the power on and Windows® running, connect 
the Type 5691A or Type 5695 DAQ System for 
BioWare to an available USB port on your computer 

3. Windows® will recognize this device as a new device 
and will install the appropriate drives for this device. If 
prompted for a driver disk, insert the BioWare 
installation CD into the CD-ROM drive and continue 

4. Windows® will load the necessary USB drivers and 
configure the Type 5691A DAQ System for use 

 
Note on USB Data acquisition systems: Any time the USB 
device is are removed and reconnected or powered off and 
on again, the INSTACAL board configuration program will 
need to be run. 
 
Proceed to the next step to configure the DAQ system. 
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4.4 Data Acquisition Board Software Configuration 

The software configuration is a two-step process. First, the 
board and data acquisition drivers need to be configured 
using the driver configuration program INSTACAL (found 
in the Kistler  BioWare program group). This configures 
the hardware using the board manufacturers' routines. 
Second, the board settings must be set in the main 
BioWare application.   
 
The Board Configuration Program, "INSTACAL", appears 
automatically the first time that BioWare is run and you 
select "Yes" when prompted if a board will be installed.  
To change the board or install a new one at a later point in 
time, locate the BioWare program group and select the 
INSTACAL icon to start the data acquisition board confi-
guration program (Fig. 4). 
 

Fig. 4: INSTACAL Board Configuration Program 

 
 

 

The Board Config program opens automatically (imme-
diately after the registration box) the first time BioWare 

is run. The A/D board dialog box appears where these 
configuration settings from Board Config should be 
made in BioWare. 
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Fig. 5: Configure screen for the 5695A DAQ system 

For the Type 5695… DAQ system choose the BOARD in 
INSTACAL and select configure. Make sure that the Board 
Configuration is appropriate, specifically, ensure the "No. of 
Channels" is set to 64 Single Ended. 
 
Once the DAQ system is configured using INSTACAL, it 
needs to be selected in BioWare as well. Launch the program 
by selecting BioWare from the BioWare for Windows® 
menu.  If this is the first time running the program, you will 
be prompted if a Data acquisitionboard will be used in 
BioWare, otherwise go to  Setup menuHardware and 
select "A/D Board". A dialog box pops up (Fig. 6) where 
you can select the settings for your board. The list shows all 
boards that are configured in INSTACAL.  
 
 

 

Fig. 6: BioWare Board configuration setup 



Installing BioWare® Software 

2812A_002-312e-02.12  Page 19 

 
The A/D bits, Available channels, and Maximum Channels 
will be automatically set reflecting the board type selected. 
The gain and acquisition mode should be set to the user’s 
specifications. The gain setting changes the scale on the 
board itself, so the lower the scale means the better the 
resolution. However, it also means a lower force range, so 
the user must be careful not to choose too high of a gain 
such that saturation occurs (i.e., be sure the forces to be 
measured do not exceed the measuring range of the 
system. If this occurs, choose a lower gain such as  
+/–10 V). 
 
The Acquisition Mode is set automatically to dma (direct 
memory access). This means that the board sends the 
acquired samples directly into the computer’s memory.   
The burst mode conversion time is the amount of time 
required to acquire one A/D sample (including settling 
time). It is automatically set to 1 uS. 
 
The Burst Mode check box allows a user to enable burst 
mode acquisition. For the USB DAQ systems the burst 
mode is always on and cannot be changed 
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4.5 Connecting the Cables 

4.5.1 Type 5691A… DAQ System 

There are (2) 37-pin cables that connect the 5691A data 
acquisition box to the max. 2 force platforms. The 
connection to the user’s PC (optional) is via USB. 
Furthermore there is a BNC female connection for an 
external trigger (trigger in). In addition, there is an USB 
extension port. To properly connect the cables: 

 
1. Turn off the power and disconnect power cords to the 

computer 
2. Connect the 37-pin cables from the Data Acquisition 

system to the force platforms. With the USB-cable 
connect the DAQ system to your PC.  

3. By a BNC female connection the DAQ System can be 
connected to other measuring systems (e.g. EMG, 
Visual Systems). Additionnaly, a free USB extension 
port is available. 

4. Plug in the DAQ box 12 Volt DC power to a wall socket 
using the provided power transformer 

5. Be sure to tighten any cable-fastening screws by hand 
to secure the cable connections and prevent slippage 
(Do not over tighten) 

 

 

The Type 5606A junction box should only be plugged 
into a wall socket if a plate with integrated amplifier is 
connected to the system. 

 
If the cables are not long enough, additional cables could 
be connected to the original ones to extend their lengths. 
Excessively long cables are not recommended because 
insulation may not be adequate to prevent interference 
and loss of signal. 
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4.5.2 Type 5695… DAQ System 

 

 
There are (2) 25-pin cables that connect Type 5695… data 
acquisition box to up to 8 force platforms. The connection 
to the user’s PC (optional) is via the USB cable. 
Furthermore there is a 9-pin Control I/O input for 
connection with the adapter box Type 5767. This box 
allows you to connect other measuring systems (e.g. Visual 
Systems, EMG) via BNC. In addition, it is possible to 
interpose the external control unit Type 5233A2 between 
the force plate and the DAQ system.  
1. Turn off the power and disconnect power cords to the 

computer 
2. Connect the 25-pin cables from the Data Acquisition 

system to the required number of force platforms. With 
the USB-cable connect the DAQ system to your PC. 
When a manual control with analog signal output of 
the force platforms is required interpose the External 
control unit Type 5233A2 between the DAQ system 
and the force platform 

6. Plug in the DAQ box 12 Volt DC power to a wall socket 
using the provided power transformer 

7. Be sure to tighten any cable-fastening screws by hand 
to secure the cable connections and prevent slippage 
(Do not over tighten) 

 

 

The Type 5606A junction box should only be plugged 
into a wall socket if a plate with integrated amplifier is 
connected to the system. No external power is 
necessary for plates with external (Type 9865) 
amplifiers. 

 
If the cables are not long enough, additional cables could 
be connected to the original ones to extend their lengths. 
Excessively long cables are not recommended because 
insulation may not be adequate to prevent interference 
and loss of signal. 
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4.6 Important Issues Regarding Piezoelectric Force Plates 

Please take care to follow these rules applying to installa-
tion and handling of plates and connections: 
 
 Protect the signal conditioner and cable connector ends 

from dust and moisture. Close end caps 
 Force plate mountings must be level 
 Use caution connecting and removing the cables. Also 

take care to not step on the cable connections to avoid 
shearing off the cable 

 Be sure to short the cable pins prior to connecting to 
devices to remove static charge 

4.7 Charge Amplifiers 

BioWare automatically controls the range selection and 
operate/reset functions of both integrated and Type 9865 
charge amplifiers. Charge amplifiers should be allowed to 
warm up sufficiently for most accurate measurements, 
with 30 minutes being a minimum. If you are using a 
Type 9865 amplifier, be sure that the Operate/Reset 
switch is set to "Remote". Unplug the amplifier if it is not 
to be used for a very long time. 

 

 

Charge amplifiers can be left on for extended periods 
of time with no adverse effects to them and with 
minimal power consumption. This ensures that the 
electronics have settled to a constant operating 
temperature. 
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5. BioWare® Software Overview 

BioWare is an easy-to-use data acquisition and manipu-
lation program. The typical Windows® controls apply to 
the graphs and dialog boxes in BioWare. This section will 
give you a quick overview of the capabilities of BioWare. 
 
The menu bar is your access to all areas of BioWare. It is 
divided into sections covering specific functions such as 
data acquisition, data viewing, file handling, equipment 
control, window control, and obtaining help. In addition to 
the menu bar, there is a toolbar similar to those found in 
major word processing and spreadsheet programs. The 
toolbar consists of icons that execute a specific function 
when clicked. Examples of these functions are acquiring 
data, configuring devices, and obtaining help. 
 
The user has full control over data acquisition. Sampling 
rate and length of trials, as well as amplifier range and 
trigger options are all easily accessible, along with control-
ling any auxiliary devices being used. The units of data 
acquisition can be customized, including normalizing force 
measurements by body weight. Normalizing force data 
means dividing the forces by the subject's body weight and 
showing the force data as a percentage of total body 
weight. In this way, direct comparisons are possible bet-
ween a 110-lb. subject and a 275-lb. subject with respect 
to their typical force parameters. 
 
The graphs are designed to be easy to read, and can be 
fully customized. The number of graphs to view can be 
chosen, along with default parameters so each trial is 
readily viewed in a format that is most useful to the user.  
Graphs can be controlled together as a group, or indivi-
dually configured by right clicking on a specific graph to 
bring up a graph menu. The line styles and colors can be 
changed by the user as desired, as can font type, font size, 
titles, and axes labels. Graph legends and grids can be 
turned on or off with ease. The parameter-versus-time 
graphs can be viewed on a relative time axis or by contact 
times that are automatically calculated based on a contact 
threshold and can be edited by the user. In addition, stored 
trials can be "time-sliced", permanently eliminating 
unwanted sections of data and thus reducing the disk 
space needed to store that particular trial. 
 
A database keeps track of all devices configured for the 
system. The devices (plates, amplifiers, etc.) contained 
within the database can be controlled effortlessly. Adding, 
editing, and deleting of configurations is simplified. The 
Device Manager shows all configured devices, and is where 
devices are made active or inactive. New devices are added 
to the system here through a handy Wizard function. 
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Fig. 7: The Device manager shows all configured devices, 
active and inactive 

If you have questions at any time while in BioWare, simply 
press the F1 key and the BioWare on-line help window 
appears. Help is also available from the menu bar.  

5.1 Quick Start 

This section will help familiarize the new user with 
BioWare. Data cannot be acquired until all devices are 
properly configured within BioWare. This section is meant 
as an overview to the features of BioWare that will be 
applied to acquired trials and graphs once the proper 
configurations have been performed. For more information 
on configuring BioWare, refer to Section 4. 
 
Start BioWare by choosing Start  Programs  BioWare 
for Windows®  BioWare.  The splash screen (Fig. 8) 
appears briefly. You will be asked to register your BioWare 
upon first time use. Note that the menus will have different 
appearances (options) based on whether or not a graph is 
shown on the screen. 
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Fig. 8: The BioWare for Windows® splash screen appears 
for a few seconds each time the program is started 

The File menu allows you to open stored trials, overlay 
multiple trials, print, save, and exit the program. The print 
setup can be customized here also. Feel free to open some 
of the supplied trials and manipulate them at will to help 
become familiar with the program’s capabilities. 
 
The Data menu is where acquisition is performed. Choo-
sing Acquire Trial will bring up the Acquire Data Dialog Box 
(Fig. 9) shows the active devices and configuration. 
Changes to the configuration can be made by pressing the 
Setup button in the dialog box. The Data menu also allows 
you to perform Time Slices and edit the start times and 
contact times for the currently viewed trial 

Fig. 9: The Acquire Data Dialog Box shows the current 
trial information 
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The Setup menu (Fig. 10) allows the user to configure 
BioWare to his/her preferences. The graph defaults apply 
to all graphs as they are first shown. Individual graphs can 
be customized further by right clicking on the desired 
graph (Fig. 11) to bring up a menu, or by double clicking 
on a specific feature of the graph (line, title, etc.) and 
editing it. The setup can be changed at any time without 
adversely affecting the data in any way. 
 

Fig. 10: The Setup menu allows the user to customize the 
graph defaults 

Fig. 11: Right click on a graph to bring up a menu to 
change its appearance or content 

Two other menus appear when a graph is shown, the View 
menu and the Window menu. The View menu allows the 
user to edit the number of graphs on the screen and the 
default parameters to be shown on the graph. There are 
also commands to copy the graphs to the clipboard for 
pasting into other documents, and for hiding/unhiding the 
toolbar and status bar. The Window menu uses standard 
Microsoft Windows® commands to create new windows 
or to tile the ones on screen. 
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6. Kistler Force Plate Calculations 

 

Fig. 12: The Kistler Coordinate System 

 

Parameter Calculation Description 

Fx = fx12 + fx34 Medio-lateral force 

Fy = fy14 + fy23 Anterior-posterior force 

Fz = fz1 + fz2 + fz3 +fz4 Vertical force 

 | Ft | = sqrt (Fx * Fx + Fy * Fy + Fz * Fz) Resultant force 

Mx = b * (fz1 + fz2 - fz3 - fz4) Plate moment about X-axis 

My = a * (–fz1 + fz2 + fz3 - fz4) Plate moment about Y-axis 

Mx’ = b * (fz1 + fz2 - fz3 - fz4) + Fy*az0 Plate moment about top plate surface 

My’ = a * (–fz1 + fz2 + fz3 - fz4) - Fx*az0 Plate moment about top plate surface 

Mz = b * (–fx12 + fx34) + a * (fy14 – fy23) Plate moment about Z-axis 

Tz = Mz - Fy * ax + Fx * ay Free moment, Vertical torque 

COF x = Fx / Fz Coefficient of Friction in x direction 

COF y = Fy / Fz Coefficient of Friction in y direction 

| COF xy | = sqrt( COFx * COFx + COFy * COFy) Coefficient of Friction resultant 

ax = (Fx * az0 – My) / Fz 

= – My’ / Fz 

X-Coordinate of force application point (COP) 

ay = (Fy * az0 + Mx) / Fz 

= Mx’ / Fz 

Y-Coordinate of force application point (COP) 
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  Kistler ISB (Reactionary) 
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7. The File Menu 

Depending on whether or not a graph is open on the 
screen, the File menu will have a different appearance. If 
no graph is open, there will only be commands to open, 
setup printing, and exit BioWare. In addition, there will be 
a list of recently opened trials that can be clicked on as a 
shortcut to reopen them. 

7.1 Open… (CTRL+0) 

This will bring up a dialog box (Fig. 14) where the desired 
trial can be selected for viewing.  The default directory is 
the data directory, though the dialog box can be easily 
navigated using standard Windows® 95 techniques to 
browse other drives, directories, and network computers. 
The extension for the trials are "*.dat". Multiple files can 
be selected by holding the <shift> key (range of files) or 
the <ctrl> key (individual selection) while selecting files.  
Files stored in BioWare 2.x format will automatically be 
converted and loaded. It can be saved in BioWare 3.0 
format by using the Save As… command. 
 
Selecting a file and pressing F2 will allow you to rename a 
file. Selecting a file and pressing DELETE will allow you to 
delete a file. 

7.2 Import Data Series… 

ASCII data series can be imported by selecting the desired 
"*.txt" file to import.  This will allow a formatted text data 
series to be imported into BioWare. See File Save As… 
(Export Data series) on formatting of the data series. Data 
series imported will be treated as auxiliary devices and will 
appear in the auxiliary device list. For example, exporting 
Fx, Fy, and Fz of force plate data trial, and then importing 
them back into a document will display them as 3 auxiliary 
devices Fx, Fy, and Fz. Further force plate computations 
(i.e.: calculation of moments, COP, etc…) is not possible. 
 
If a trial document is open when you select import data 
series, a prompt will appear asking if you want to add the 
imported data to the current document, or to create a new 
document based on the imported data series. 
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7.3 Export Files (Convert binary files to ASCII) 

This menu option appears only when all files are closed. 
The export file will export basic trial data to a standard 
ASCII text file. The standard file open dialog box will 
appear displaying a list of files available to open. You may 
select which files to convert from BioWare native binary 
format to the ASCII format. Multiple files can be selected 
by holding the <shift> key (range of files) or the <ctrl> key 
(individual selection) while selecting files. Files stored in 
BioWare 2.x format will automatically be converted and 
loaded.  
 
Once the files are selected, pressing the open button will 
present you with the export options where you can select 
various options for calculating the COP data. You can 
choose which force plate parameters you want to convert 
to ASCII files. Select the desired options and press OK. 
 
Note: The Export Data Files option will automatically 
convert and export "All" devices in the trial to the ASCII 
file.  You cannot select which specific devices to export. 
 
See chapter 7.6 for more information on exporting files 
and the exported file format. 

7.4 Merge… 

Merge… is a function that overlays multiple plots for direct 
comparison. To use Merge, first open a file that will be 
overlaid with another by using the Open… command, and 
then select Merge from the File menu. Select the file to 
merge with the current file on screen from the dialog box, 
and press OK. The two trials will be overlaid in the same 
window, where they can be directly analyzed.  More than 
one file can be merged together one at a time. However, 
as more and more files are added the graphs becomes 
crowded and cluttered, so it is good practice to overlay a 
maximum of three to four files. Use the Save As… function 
to save a new file of overlaid trials. Doing so will keep the 
individual trials separate from the merged file. Saving 
merged files does take up additional disk space, though, so 
only save the overlays if absolutely necessary 

7.5 Save… 

Save… will save any changes made to the current trial on 
screen. The current name and file location are used. In 
essence, the file is overwritten with the data on screen. If 
you are not sure if you want to replace the trial with the 
current one, use the Save As… function instead of Save… 
and use a different filename. 
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7.6 Save As… (Export) 

This allows the user to take the current graph on screen 
and save it under a different name and/or a different file 
location. This is useful when using the Merge… function, 
or when making changes to a trial that you would like to 
save without permanently altering the original file. A dialog 
box appears when this command is selected that allows the 
user to choose the file name and location. By default all 
files are stored with the data extension "*.dat" in 
BioWare’s native binary format. 

 
Files may be export to ASCII tab delimited files, DIFF 
format files, or DIFF+INF files. The Data Interface File 
Format (DIFF) is a standard used in Japan to store time 
series data for Gait Analysis. The DIFF format was 
developed by the Clinical Gait Analysis Forum of Japan and 
it is usable for any time series data.  
The web site http://www.aist.go.jp/NIBH/ourpages/ 
comparison99/DIFF-SPEC.pdf describes the DIFF standard. 

  
Files may be exported to ASCII tab delimited text files by 
selecting "Text file (*.txt)" in the Save as Type. The 
exported device data will be in a "reduced" format, mea-
ning that all forces and moments are already calculated 
from the raw voltages. The user can select which para-
meters (including performance parameters) to export and 
which device data to use. The Export Data dialog box (Fig. 
13) is very similar to the View Manager, with a very 
straightforward interface. To export data, first select the 
device from the Device List. Next, select the desired time 
scale from the Time list and place a check in the boxes 
whose data is to be exported. If center of pressure (COP) 
parameters are selected, select whether or not to use COP 
correction and/or to Automatically center the COP values 
from the Center of Pressure Options. When ready, press 
the "Export Data" button. Choose the name (and location) 
for the exported file from the box that pops up, and click 
OK to complete the export. Another box pops up to 
confirm that the data was exported, showing the export 
path and filename. An example of an exported file is 
shown below. To export all devices in the trial select "All" 
from the device list. 
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BioWare 3.0 Export  
Device: Plate 1 Plate 2 Aux
Samples (#): 251 251 251
Rate (Hz): 250 250 250
Contact period start (sample #): 8 16 0
Contact period end (sample #): 234 247 250
Contact period start time (s): 0.032 0.064 0.0
Contact period end time (s): 0.936 0.988 1.00
First sample time (s): 0 0 0
Normalized force (N): 800.6796 800.6796 1
Normalized length (m): 1 1 1
Absolute time (s) Fx Fx EMG 

N N mV 
1.864 –0.15392 0.107193 1.557735
1.868 –0.23022 0.183487 3.003304
1.872 –0.15392 0.011826 2.521448
1.876 –0.21114 0.011826 3.083614

… … … … 
2.852 –0.30651 –0.10262 2.682067
2.856 –0.28744 0.183487 1.156188
2.86 –0.0967 –0.06447 1.878973

2.864 –0.19207 –0.00725 1.878973
done exporting  

 
Similar to the Edit parameters dialog box, the export data 
dialog box has a "View Performance" button for selecting 
performance parameter data sets to export. All of the 
parameters are identical to those under the Edit Parame-
ters… section of this manual, see chapter 9.2 for more 
information. Fig. 13 shows the Data Export dialog box with 
the Performance Parameters selection box opened. 
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Fig. 13: Export Dialog with Performance Parameters 

 

Fig. 14: The Open BioWare File dialog box 
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Fig. 15: The Print Setup dialog box 

7.7 Close 

This will close the currently selected window. If any 
changes were made to the file since it was opened then a 
dialog box will prompt you with an option to save the 
changes before the window is closed. If multiple windows 
are open, this function will only close the current (high-
lighted) window. 

7.8 Close All 

Close All performs like the Close function, but it will close 
all windows on the screen. If changes were made to any 
files, you will be prompted to save the files if you choose.  
This is a handy function when too many windows are open 
and the analysis is completed on them, but you do not 
wish to exit the program yet. Close All brings BioWare to 
its initial state, with no open windows. 

Fig. 16: The Print dialog box 
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Fig. 17: The Print Preview dialog box lets you take a look 
at your printout before printing 

7.9 Print Setup… 

Print Setup…  allows the user to configure the printing to 
his/her specifications. A dialog box (Fig. 15) appears when 
this function is selected. Standard setup functions are to 
select the printer, paper size and tray (if applicable), and 
the paper orientation. A Properties button allows you to 
further customize printer settings. 

7.10 Print (CTRL+P) 

Print brings up the Print dialog box (Fig. 16) that uses the 
default print settings. The user selects the print range and 
the number of copies to print. The highlighted window is 
the data that is to be printed, so be sure to select the 
correct graph window before choosing the print function. 

7.11 Print Preview 

Print Preview allows the user to see what the printout will 
look like (see Fig. 17), so that any necessary changes can 
be made before the print function is carried out. This is 
very useful in preventing unnecessary paper waste, and it 
lets the user make sure the printout is exactly as it is 
supposed to be. From this dialog box you can zoom in on 
the image for a closer look, view more than one page at 
once, and execute the Print function. 
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7.12 (Recently Used File List) 

The previous 10 files that were opened or saved appear in 
reverse order of selection (i.e., most recent to least). This 
convenience acts as a shortcut for the user because it is 
often necessary to reopen trials more than once for statis-
tics and analysis. 

7.13 Exit 

Exit closes BioWare. If any files are open and changes have 
been made, the user will be prompted to save the changes. 
In addition, any changes to the default setup (see the 
Setup Menu section of this manual) will be saved. 
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8. The Data Menu 

The Data menu is where all data acquisition and editing are 
performed. Before any trials are performed or any files are 
open, the menu is limited to the Acquire Data and Acquire 
Direct functions. All other functions listed below are avai-
lable once a trial is performed or a stored file is opened. 

8.1 Acquire Data 

The Acquire Data dialog box (Fig. 18) allows the user to 
customize the trial to their specifications and to configure 
the hardware used in the system. The trial length and 
sampling rate are set in the upper right corner of the box.  
The length is in seconds and the sample rate is in Hertz 
(cycles per second). The total number of samples acquired 
is calculated by multiplying the trial length times the 
sampling rate times the number of channels. The more 
samples acquired results in a greater amount of disk space 
used to store the trial. 
 

Fig. 18: The Acquire Data dialog box 

 



 BioWare® Software Type 2812A… 

Page 38  2812A_002-312e-02.12 

Fig. 19: Acquisition Setup dialog box 

 
The direction is set by in the Direction Control section.  
Automatic direction switching can be chosen from the 
Acquisition Setup dialog box (Fig. 19). Pressing the Setup 
button from the Acquire Data dialog box (see chapter 8.2) 
accesses this dialog box. Direction defines the orientation 
the subject approaches the plate. Selecting "Backward" 
causes the coordinate system to be reversed after the trial 
is acquired. This allows direct comparison of trials taken 
from either direction. 
 
The subject’s weight should be entered in the Weight 
section of the Acquire Data box only if normalized studies 
are to be performed. Normalized studies are those where 
the measured force is divided by the body weight. This 
allows studies to be performed on subjects of all sizes and 
weight ranges. Normalized units are body weights. 
 
To begin acquiring data, press the Start button. Acquisition 
begins when the selected trigger requirements are satisfied. 
To close the box and store changes without acquiring data, 
press Close. Press Cancel to close the dialog box without 
accepting any changes made. 
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8.2 Acquisition Setup 

The Acquisition Information section of the Acquire Data 
box (Fig. 18) shows the settings for data acquisition  
that can be configured in the Acquisition Setup dialog box 
(Fig. 19). The following parameters are configured: 

 Trigger Options refers to the trigger type used when 
acquiring trials. There are seven options: 

1. On a Key: Acquisition begins when the user presses the 
Start Button from the Acquire Data dialog box, or when 
Acquire Direct is chosen from the Data menu. If the 
plate/amplifier is setup to read a zero offset, then this 
will be done prior to acquisition and an additional 
prompt will appear before acquiring data 

2. Above a level:  Data is not acquired until the set voltage 
on the selected channel is exceeded 

3. Below a level: Data is not acquired until the voltage 
measured on the selected channel falls below the set 
value 

4. Digital Rising Edge – the trigger level goes from low to 
high (switch opening). 

5. Digital Falling Edge – the trigger level goes from high to 
low (switch closing) 

6. Digital High Level – triggers on first instance of a high 
(switch open) 

7. Digital Low Level – triggers on first instance of a low 
(switch closed) 

8. Hardware Digital – triggers using low level a/d board 
digital trigger capability. Requires a small modification 
to Type 5606A junction box. This is method has redu-
ced latency between the trigger and the first acquired 
sample 

 
 Auto Save Options allow the acquired data to be 

automatically stored as a filename with an accumulating 
index number. Many times a user wants to acquire 
multiple trials immediately and perform the analysis at a 
later time.  By placing a check in the Auto Save "On" 
box, the filename box becomes enabled and the user 
can choose the name and location of the file. To do 
this, press the Change button and a standard 
Windows® box pops up where you can select the 
desired directory, which is shown in the box at the top 
of the box. Drop the directory box (by pressing the 
downward-pointing arrow at the immediate right of the 
directory box) to view the entire path to the selected 
directory. Once the directory is chosen, enter the 
filename in the box labeled "Filename2. The entire 
directory path does not necessarily need to be entered 
on this line if the correct directory had been already set. 
The filename will have a 3-digit index number 
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appended at the end, beginning with "000". For 
example, if the saved filename is entered as "Example", 
then the first trial will automatically be saved as 
"Example 000.dat"  and the next will be "Example 
001.dat", and so on. BioWare will check for the last 
used index number stored in the directory and will save 
the next trial incremented by one. The "show graph for 
each cycle" enables the graph to be drawn after each 
cycle is acquired 

 
When Auto Save is enabled, upon acquiring the first 
trial BioWare assumes that more trials will follow and 
consequently continues to acquire trials automatically 
(while still waiting for the designated trigger to 
activate).  For example, if the trigger type is "on a key" 
then as soon as a trial is concluded a box pops up 
prompting the user to press a key to acquire the next 
trial. This will continue indefinitely until the user presses 
the Escape key to cancel the Auto Save process 
 

 Pretriggering – When analog triggering is enabled, 
pretriggering will define the percentage of the trial to 
appear before the actual trigger occurs. For example, 
specifying a 10 % pretrigger, on a 10 second trial with 
0.1 volts on channel 7 will result in a trial with 1 second 
of data prior to channel 7 reaching 0.1 volts, and 9 
seconds of data after channel 7 reaches 0.1 volts. This is 
useful for capturing force plate data where events 
leading up to the plate contact are important.  The user 
may also enter the pretrigger in number of A/D sam-
ples.  Note, the pretrigger is calculated as a percent of 
the total number of samples. When selecting the A/D 
samples option, a change in the sampling rate will 
change the number of pretrigger samples, as the 
pretrigger percentage will remain constant 

 
 Automatically Switch Coordinate System Direction can 

be on or off, and determines whether or not the plate 
orientation automatically alternates for consecutive 
trials. When direction control is on the approach to the 
plate should be along the long axis of the plate, and for 
the next trial should be from the opposite side of the 
plate and still along the long axis. Thus, a subject on a 
runway can approach the plate from either direction.  
The intent is to shorten the time between trials and to 
lessen walking effort for the subject, by allowing them 
to walk along a runway and approach the plate from 
either direction without having to return down the 
runway to a single starting point each time. Place a 
check in the box to enable automatic direction control. 
Note: check the direction for each trial to ensure that it 
is correct, and manually override if it is incorrect 

 
 Oversample Data – if enabled, a sample rate can be 

specified to acquire data, the data is later processed and 
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resampled post acquisition (using a spline algorithm) to 
the desired sampling rate in the acquisition dialog box 

 
 S/W Correct for A/D clock skew – if enabled, an algo-

rithm is used to correct for inter-channel timing diffe-
rences for a single A/D scan. This is particularly useful 
for A/D boards that do not support "burst mode" and 
for lower sampling rates. The algorithm simulates a 
simultaneous sample and hold A/D board provided the 
raw data is sufficiently over-sampled.  It is ideally suited 
to calculations based on several raw individual channels  

 
 Delay after trigger – allows for a delay between the 

trigger event and the actual sampling time 
 
 Beep at End/Start Acquisition causes the default 

Windows® sound to play immediately prior to / after 
acquisition 

 
 Apply Averaging Filter – if enabled, an averaging filter 

is applied to the data set. See the section on digital 
filtering for more information 

 
 Keep Original Data Set – for any of the above 

acquisition options that modify the acquired data 
(resampling, filtering, etc…) this option allows for the 
raw data (prior to modification) to be saved in the file 
as another data set 

 
 Show Prompt before acquisition – enables Displaying a 

prompt just prior to the acquisition going into the 
"waiting for trigger"  mode 

 
Pressing the Device Setup button from the Acquisition 
Setup dialog box brings up the Device Setup dialog box.  
Refer to chapter 14 of this manual for a description of 
Device Setup. 

8.3 Acquire Direct 

Many times the acquisition settings do not change from 
trial to trial, and it is not necessary to check the settings 
prior to each trial. One way to get around this is to use the 
Auto Save feature (see chapter 8.2) to acquire trials in a 
nonstop manner. Another way is to use the Acquire Direct 
function from the Data menu. When this function is selec-
ted, the acquisition process begins immediately using the 
default settings (i.e., trigger type, sampling rate, sampling 
time, etc.), without opening the Acquire Data dialog box. 
This does not save trials automatically, rather it is designed 
as a shortcut to acquiring a trial. 
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8.4 General File Info… 

To edit a file header (i.e., name, ID, Classification, trial 
description), select General File Info… from the Data menu 
after opening a graph of the file (Fig. 20). The date and 
time of the trial are shown in a box that cannot be edited.  
All other fields can be edited by placing the cursor in the 
desired box and typing in the required information.  Click 
OK to store the changes or Cancel to close the box without 
saving any changes to the file header. All fields have no 
specific format; each user can decide what to use as ID’s 
and Classifications to satisfy their own needs and require-
ments. The description should be used to illustrate any 
highlights of the trial, such as observations made or 
assistive devices used. 
 

Fig. 20: The file information dialog box allows you to store 
information about the trial 

8.5 Device Info 

Each device that is used in a trial has specific settings and 
parameters that may need to be set or changed by the 
user, such as serial numbers and sensitivities. This is accom-
plished by selecting Device Info… from the Data menu. A 
dialog box pops up (Fig. 21) showing general information 
about the device, and buttons labeled with names of 
parameters that can be adjusted. For trials that had more 
than one device connected to the system, the device to 
edit should first be chosen from the list box at the top of 
the dialog box. The full list can be viewed by clicking on 
the down arrow to the right of the box. Depending on the 
type of device selected not all buttons may be available.  
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For example, force plates with integrated amplifiers – such 
as the one in Fig. 21 – will not have the "Amplifier" button 
available because amplifier ranges are combined with the 
force sensor sensitivities, and are set from the "Sensiti-
vities" button. 
 

Fig. 21: The Device Information dialog box allows you to 
check device settings for the trial 

 
Each device has a specific name, type, and serial number 
that should be entered in their respective fields. The button 
descriptions are as follows: 

8.5.1 Direction… 

Direction control is useful when doing studies that utilize a 
runway approach to the force plate. By being able to 
change the orientation of a fixed plate, the subject’s 
approach to the plate can be from either direction on a 
runway. This will shorten the time between trials and 
shorten the amount of distance traveled by the subject, 
which is handy when doing studies on subjects with 
pathologies and/or disabilities. The Direction… button is 
used to check the orientation of the device, and to change 
the direction if necessary (see the section on Direction 
Control in the Setup menu part of the manual). Changing 
direction  should only be performed if the user is absolutely 
sure that the incorrect direction was used for the trial.  
Direction selection is only available for force plate devices, 
and is disabled when auxiliary devices are selected. 
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Fig. 22: The direction dialog box 

8.5.2 Sensitivities… 

Pressing the "Sensitivities" button allows the user to check 
the sensitivities of the force plate or auxiliary device that 
are used for the calculations, and to edit them if necessary.  
It is strongly advised that these sensitivities not be changed 
unless the user is absolutely certain that they are incorrect.  
The dialog box that appears when the button is pressed 
will be either for an eight-channel force plate with external 
amplifier (Fig. 23), an eight-channel force plate with inte-
grated amplifier (not shown) or a single-channel auxiliary 
device (Fig. 24). 
 

Fig. 23: The sensitivities for an eight channel force plate 
with Type 9865… amplifier 
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Fig. 24: The sensitivity for a single channel auxiliary device 

 

8.5.3 Orientation… 

Orientation is used when a plate is oriented with respect to 
a point other than its own center, such as when multiple 
force plates are attached to the system. It is generally not 
necessary when only one plate is configured. Fig. 25 shows 
the dialog box with the three parameters for defining the 
plate orientation. Alpha is the angle from the force plate’s 
y-axis to the y-axis of the coordinate system. dx and dy are 
the distances from the center point of the reference 
coordinate system to the center point of the plate, in the x 
and y directions respectively. 

Fig. 25: The orientation dialog box 
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Fig. 26: Diagram illustrating the definition of force plate 
orientation 

8.5.4 Amplifier… 

Available only for plates with external amplifiers, the 
Amplifier Information dialog box (Fig. 27) shows the 
current amplifier range selected for each force sensor, as 
well as the name, type and serial number of the amplifier 
used with the device.   

8.5.5 COP Enhancement… 

Some eight-channel plates have Center of Pressure 
enhancement variables that, when activated, implement an 
algorithm based on these variables to more accurately 
calculate the center of pressure of the force plate. Fig. 28 
shows the COP Correction dialog box. Default variables 
can be loaded by selecting the correct device from the list 
at the bottom of the box. Click OK to save any changes, 
and click Cancel to close the box without saving. 
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Fig. 27: The amplifier information box shows the range 
setting for the current trial 

 

Fig. 28: The Center of Pressure correction variables for the 
selected device 

8.5.6 Plate Settings… 

Only available for force plate devices, this box shows the 
dimensions of the force plate in millimeters. Fig. 29 shows 
the Plate Settings dialog box, and Fig. 30 illustrates the 
setting definition. 
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Fig. 29: The Plate Settings dialog box 

 

Fig. 30: The plate settings are illustrated in the above 
drawing 

8.6 Contact Times… 

This function appears whenever a graph is open in 
BioWare. It allows the user to set the start and finish 
contact times for the currently selected graph.  The contact 
times are needed when using "Percent Contact" as the 
time scale. The default contact times are set based on the 
Contact Threshold (see Setup Menu). To edit the contact 
times from the dialog box (Fig. 31), simply choose the 
desired device from the drop box and the data gathered 
from that device shows up in the graph window. The 
default start and finish contact times are shown in their 
respective boxes just below the device list box. 
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Editing the contact or start times does not affect the 
data in any way.  It is only used as a reference when 
viewing data with a time scale of Percent Contact.  The 
default contact times are based on the Contact 
Threshold, from the Setup Menu. 

 

Fig. 31: The Edit Contact Times dialog box 

Fig. 32: The same graph as in Fig. 31, zoomed in to assist 
with positioning cursors 

There are two ways to set the contact times; either type in 
new values directly or use moving cursors on the graph to 
set the times. In either case the user can zoom in on the 
data to get a closer look at the exact points of contact by 
right clicking the mouse and dragging a box around the 
desired viewing area (Fig. 32). If you choose to type in the 
values, look at the graph and type in the values for start 
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and finish and press the Change Contact Period button.  
To use the moving cursors click on the graph with the left 
mouse button and hold it down, and position the green 
(start) and red (finish) vertical lines in the proper positions, 
one at a time. The values for start and finish times change 
as the cursor moves about the graph, reflecting its current 
position. Release the mouse button when each is in posi-
tion. Notice that you cannot place the start cursor beyond 
the finish cursor, and vice-versa. Zoom in on the graph to 
assist in positioning the cursors. Zoom out by clicking the 
corresponding toolbar icon or by choosing Zoom Out from 
the Window menu. Press Change Contact Period when 
ready. Click Exit to close the dialog box. Any changes 
made to the contact times cannot be undone. 

8.7 Start Time… 

This function allows the user to change the time scale to 
their preference. Often the time period of a trial that the 
user is interested in does not begin at zero seconds, and 
the user would like to change the axis so that the force 
data begins at "time = 0 seconds". This can be done by 
editing the start time of a trial.  In essence, editing the start 
time will "shift" the time axis so that time zero occurs at 
the point where measurable force is first recorded, or to 
any other point that the user desires. 

Fig. 33: Edit Start Time… dialog box allows you to choose 
the zero time for the trial 
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Fig. 34: The start time is now –1.61 seconds, so that the 
first point of control is at t = 0 sec 

Fig. 33 and Fig. 34 will help illustrate the use of this func-
tion. Fig. 33 shows a walking trial where the subject first 
contacts the plate 1.61 seconds after acquisition begins 
(i.e., time = 1.61 seconds). To set this point of first contact 
at zero seconds we need to "shift" the time axis to the 
right by 1.61 seconds while "holding" the graph in place. 
We position the cursor where we would like time = 0. You 
can zoom in on the graph using the usual zooming 
method. Pressing the "Set Start Time" button will update 
the data set, including all graphs on screen (see Fig. 34).  
This places the zero time at first contact as we had selected 
Now look at the time of start of the first data set.  It begins 
at time = –1.61 seconds. We have essentially "shifted" the 
time axis, without otherwise altering any data. 

8.8 Normalizations… 

This function will open a dialog box that allows the user to 
choose a device and enter a body weight and a length for 
normalization (see Fig. 35). Normalized force data has 
"Body Weights" as the unit of measure. For example, a 
subject who stands on a scale with units of Body Weight 
would read the value "1" as their weight. It is a handy unit 
of measure for comparing subjects of all shapes and sizes. 
To set the normalized value, choose Edit Normalizations… 
from the Data menu and select the device measuring the 
force or length, and enter the values to be used as 
normalized. Press OK when finished, or click Cancel to 
close the dialog box without saving any changes. You will 
only notice the change when viewing the data with 
Normalized units. This does not affect the data itself in any 
way. 



 BioWare® Software Type 2812A… 

Page 52  2812A_002-312e-02.12 

Fig. 35: Enter the body weight and length to view the data 
normalized 

8.9 Time Slice… 

A great way to save disk space is to perform a time slice on 
a data file. Often a trial is taken with a wide time window 
to ensure that all desired data is gathered. However, this 
creates data files that are much larger than they need to 
be. For example, a 10-second trial taken at 250 Hz on an 
eight-channel plate would create 20 000 data points. If the 
actual time that the plate gathered useful data is 3 sec-
onds, this would mean that 14 000 samples of "useless" 
information is stored together with the 6 000 samples of 
"good data". When experiments require 50 such trials, the 
useless information really piles up. Time slices remove 
unnecessary data from the file while maintaining only the 
pertinent data.   
 

 

Great care should be taken when performing time 
slices.  It is a permanent operation. The data that is 
removed cannot be restored. Please make sure that the 
correct data is being saved and that only unwanted 
data is being deleted. 

 
A time slice is performed by defining a starting and ending 
time for data you wish to keep. All data outside the 
designated range will be eliminated from the file. Only one 
range can be defined per trial. This means that if there are 
two distinct regions of pertinent data from a single file that 
you wish to keep, then you will need to define the start of 
the time slice at the start of the first range, and the end of 
the time slice at the end of the second range. Fig. 36 and 
Fig. 37 will illustrate an example of a time slice.  
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Fig. 36 shows an example of a 3-second gait trial, of which 
there is less than one second of useful data. We would like to 
perform a time slice to eliminate the unwanted data and cut 
down on used disk space. From the Data menu we select 
Time Slice… and choose the selected device from the Device 
List. Then we position the moving cursors at the start and 
finish of the gait cycle. The green cursor is positioned at the 
start and the red at the finish, by holding down the mouse 
and dragging the cursors into position. We can zoom in for a 
closer look by right clicking and dragging a box around the 
zoom window. Once the cursors are in position we click on 
the button labeled "Time Slice Data Set". A confirmation box 
reminds us that the data outside the selected range will be 
permanently eliminated, and we click Yes to continue. Fig. 37 
shows the newly time-sliced data. We click exit to close the 
dialog box. 

Fig. 36: The time-slice function eliminates unwanted data… 

Fig. 37: The same data set with unwanted data time-sliced 
out of the file 
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It is a good idea to edit the start time after performing 
a time slice, to make the first data point occur at 
time = 0 seconds (see chapter 8.7). 

8.10 Filter… 

Filtering is used to "smooth" a data set or to remove some 
frequency content. The type of filter to use depends upon 
the type of modification required. The filtering options are:  
1) Moving Mean, 2) Moving Median, and 3) Digital Filte-
ring.  Each is discussed in the following paragraphs. To 
access the filtering dialog box (Fig. 38), choose "Filter…" 
from the Data menu. Select the device to filter from the 
device list, and choose the type of filter to use. Click Apply 
to apply the selected filter, and click Done to close the 
dialog box. 

8.10.1 Moving Mean (Average) 

A moving mean filter is used to smooth an entire data set 
when no particular frequencies are to be filtered out. This 
type of filter generates a moving average data set from the 
original one, based on a user-specified "window size". The 
window size specifies how many values to the left and 
right of the current value are averaged. The window size 
must be an odd number, because the current value must 
fall in the exact center of the window, with an even 
number of points to the left and right of it. The average of 
all values in the window is calculated, and this number is 
used to replace the current value. The larger the window 
size, the more the resulting data set is smoothed. Fig. 39 
illustrates both the moving mean and the moving median 
filters. 
 

Fig. 38: The Filter dialog box 
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8.10.2 Moving Median 

The moving median filter is similar to the moving mean in 
that it also uses a moving window. However, this method 
sorts the values within the window and replaces the cur-
rent value with the median value (i.e., the middle value in 
the sorted data window). The moving median type filter  
is good for removing sharp spikes in the data. Refer to 
Fig. 39 to see an example of how the moving median filter 
works. 

Fig. 39: Illustration of Moving Mean and Moving Median 
filters 

 

 

When using either a moving mean or moving median 
filter, be sure to enter the desired window size before 
applying the filter. The window size must be an odd 
number to keep the current data value centered in the 
window. 

8.10.3 Digital Filters 

Digital filters are to be used when it is known which fre-
quencies are to be removed from a data set. BioWare 

allows the user to define his/her own filters or to use 
ready-made default filters. A separate Filter Setup dialog 
box  
(Fig. 40) helps the user create a custom filter and also 
shows the current filter configuration. Each part of the 
Filter Setup dialog box will be discussed individually. Prior 
to filtering, an artificial data set is created by extending the 
beginning and ending of the data set by the computed 
filter length and filling these extensions with the first data 
sample and the last data sample respectively. This elimi-
nates the sharp corner frequencies at sample zero and at 
the last sample and will result in better filters in most cases.  
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Fig. 40: The filter setup dialog box 

 
 The Filter Type defines the range of frequencies to pass 

or stop. Low Pass filters remove the high frequencies 
and pass the low frequencies, while High Pass filters 
pass the high frequencies but stop the low frequencies.  
Band Pass filters allow a finite range of frequencies to 
pass and stop all others, while the Band Stop filters will 
stop a finite range of frequencies and allow all others to 
pass 

 Filter Approximation defines the filter equation used.  
There are four different filter approximations: Butter-
worth, Chebychev, Inverse Chebychev, and Elliptic. 
These approximations are explained in Appendix A 

 Edge Frequencies must be defined for each filter type.  
For each filter type there is a passband and  stopband 
frequency along with a passband and stopband gain, 
which define the limits of the filter. The definition of 
passband and stopband differ with filter type: 

1. For a low pass filter, the passband is the frequency 
above which all frequencies are filtered to some degree, 
and below which all frequencies pass unfiltered. The 
stopband in this case is the lowest frequency where the 
signal is completely filtered out, everything above this 
stopband frequency is completely eliminated from the 
data. The stopband is always a higher frequency than 
the passband for low pass filters. Between the passband 
and stopband the frequencies become progressively 
more filtered out as the frequency increases from pass-
band to stopband 
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2. A high pass filter is exactly the reverse of a low pass 
filter. The passband frequency is higher than the stop-
band frequency. All data above the passband goes 
unfiltered and everything below the stopband frequen-
cy is eliminated 

3. Both band pass and band stop filters are nothing more 
than a combination of high pass and low pass filters.  
The band pass filter allows a certain range of data to 
pass through and eliminates all frequencies outside the 
range. Therefore, the low pass frequency is actually 
higher than the high pass frequency. For example, a 
band pass filter that wants to only allow data with 
frequencies in the range of 500 to 750 Hz would 
combine a high pass filter of 500 Hz with a low pass 
filter of 750 Hz. The high pass filter eliminates every-
thing below 500 Hz, and the low pass filter eliminates 
everything above 750 Hz 

4. A band stop filter is the reverse of the band pass. It 
allows all frequencies to pass through except for a 
defined range somewhere within the frequency spec-
trum of the data. For example, to design a band stop 
filter of 500 to 750 Hz would mean to apply a low pass 
filter of 500 Hz and a high pass filter of 750 Hz. Only 
the data with frequencies between 500 and 750 Hz are 
eliminated 

 The filter Gains are the ratio of the signal output level to 
the signal input level. A gain greater than 1 means a 
higher output while a gain less than 1 means a lower 
output than input. The gain in the stopband is typically 
very small (e.g., 0.0001), and is often converted to 
decibels because they are much more manageable for 
very small gains. The equation is: gaindb = 20 • log(gain).  
For example, a stopband gain of 0.0001 is equal to –80 
dB.  A typical passband could be 0.707, or –3.0103dB 

 
Sometimes a time shift occurs when applying a filter, which 
shows up by overlaying filtered and unfiltered data. To 
compensate for this, place a check in the box at the bot-
tom of the Digital Filter Setup box to enable Dual Pass.  
This function filters the data once from start to finish, and 
then reverses the data set and performs the filtering again.  
When complete, it reverses the data set once again to put 
it back in the right order. Doing this minimizes any time 
shifting that may be caused by the filter. 
 
A filter is defined by specifying the passband frequency 
and the gain at which this frequency occurs, and the 
stopband frequency and the gain at which its frequency 
occurs. The diagram in the filter setup dialog box illustrated 
the filter being designed, and shows the passband and 
stopband frequencies and gains to help assist in the filter 
design. BioWare will not allow invalid filter settings, and 
will explain any errors in design. 
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8.11 Resample Data Set… 

Being able to resample a data set can be useful when 
comparing data that was sampled at different rates. This 
function will take a selected data set and resample it at the 
rate specified by the user. To set a new rate, choose 
"Resample Data Set…" from the Data menu and select the 
data set to resample from the list. The current rate will be 
shown in the dialog box (Fig. 41) along with a box to enter 
the new rate, whose default is the current sampling rate. 
Enter the new rate and click the Resample button. The 
graph will be updated and the Current Sample Rate in the 
dialog box will change to reflect the new rate. Click close 
when finished. The resampling algorithm uses a spline 
algorithm to estimate signals. 
 

Fig. 41: Data sets can be re-sampled at different rates 

8.12 Remove Data Set… 

Sometimes a file has some unwanted data attached; either 
a device that did not measure properly or a filter that did 
not perform correctly, or for some other reason there are 
data sets that are doing little more than taking up space.  
These data sets can be removed from the file by selecting 
"Remove Data Set…" from the Data menu. A dialog box 
appears (Fig. 42) with a list of data sets that are associated 
with the current file. The entire list can be viewed by 
pressing the down arrow to the right of the list box. Select 
the data set to be eliminated and press the Remove button. 
If there is only one data set associated with the device then 
the Remove button will be disabled (If this is the case then 
the entire file should simply be deleted entirely from the 
computer). Press the Close button when finished. 
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Fig. 42: It is possible to remove an unwanted data set from 
the file 

 
Device data can be exported to a tab-delimited text (*.txt) file 
in "reduced" format, meaning that all forces and moments 
are already calculated from the raw voltages. The user can 
select which parameters to export and which device data to 
use. The Export Data dialog box (Fig. 43) is very similar to the 
View Manager, with a very straightforward interface. To 
export data, first select the device from the Device List. Next, 
select the desired time scale from the Time list and place a 
check in the boxes whose data is to be exported. If center of 
pressure (COP) parameters are selected, select whether or not 
to use COP correction and/or to Automatically center the 
COP values from the Center of Pressure Options. When 
ready, press the "Export Data" button. Choose the name 
(and location) for the exported file from the box that pops up, 
and click OK to complete the export. Another box pops up to 
confirm that the data was exported, showing the export path 
and filename. 
 
 

 

Changes made to the data files are not permanent until 
the file is saved.  If a file was altered in any way, when 
it is closed or when BioWare is exited a message box 
will pop up asking the user whether or not to save the 
changes. 
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Fig. 43: Initial Conditions dialog box 

8.13 Initial Conditions… 

All initial conditions required for Performance calculations 
can be set by the user in the Initial Conditions... dialog box.  
The components of the Initial Conditions... dialog box 
include: 
 Device Selection – Allows the selection of the device for 

which the initial conditions to be set. Only force plate 
devices will appear in the selection list 

 Body Mass (Weight) – This entry boxes allow the entry 
of the subjects body mass for the currently selected 
device. The current units for body mass are displayed to 
the right of the entry box 

 

 

The body mass is the most important parameter.  All 
calculations performed in BioWare Performance are 
based on Body Mass. The weight should be measured 
on the force plate(s) before starting power 
measurements.  Weight and Mass are used "inter-
changeably" with the gravitational constant take into 
affect. 

 
The X, Y, Z Columns define the separate initial conditions 
for each of the orthogonal components X, Y, and Z in the 
chosen coordinate system. 
 
 Static Acceleration Row – This row allows for the entry 

of the static acceleration parameters used in the com-
putation of acceleration, and all subsequent accele-
ration based computations. 9.80665 m/s/s is the  
default vertical acceleration of gravity.  Note, the units 
for acceleration are defined in the Units dialog box 
located under the setup menu. The static acceleration 
allows for the removal of earth's gravity from all perfor-
mance calculations 
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 Velocity Row – This row allows for the entry of the 
initial velocity parameters used in the computation of 
velocity, and all subsequent velocity based compu-
tations. Note, the units for velocity are defined in the 
Units dialog box located under the setup menu 

 
 Displacement Row – This row allows for the entry of 

the initial displacement parameters used in the compu-
tation of displacement, and all subsequent displacement 
based computations. Note, the units for displacement 
are defined in the Units dialog box located under the 
setup menu 

 
 Calculate I.C.  Average Acceleration = 0 – The Calcu-

late Initial Conditions Average Acceleration = 0 button 
is used to automatically calculate the static accelerations 
for the selected device. If this button is selected, 
BioWare Performance will compute the appropriate 
static accelerations for the force plate which will cause 
the average acceleration over the complete trial to be 
equal to zero. The computations are performed sepa-
rately for all three orthogonal components, X, Y, and Z. 
This is useful when it is known that the subjects accele-
ration was, on average, zero 

 
 Calculate I.C.  Average Velocity = 0 – The Calculate 

Initial Conditions Average Velocity = 0 button is used to 
automatically calculate the initial velocities for the 
selected force plate. If this button is selected BioWare 
Performance will compute the appropriate initial veloci-
ties for the selected device which will cause the average 
velocity over the complete trial to be equal to zero. The 
computations are performed separately for all three 
orthogonal components, X, Y, and Z. This is useful 
when it is known that the subjects velocity was, on 
average, zero 

 
 Calculate I.C.  Average Displacement = 0 – The Calcu-

late Initial Conditions Average Displacement = 0 button 
is used to automatically calculate the initial 
displacements for the selected force plate. If this button 
is pressed, BioWare Performance will compute the 
appropriate initial displacements for the selected force 
plate which will cause the average displacement over 
the complete trial to be equal to zero. The computa-
tions are performed separately for all three orthogonal 
components, X, Y, and Z. This is useful when it is 
known that the subjects displacement was, on average, 
zero 
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9. The View Menu 

The features of the View menu are directly related to the 
look of the screen along with any graphs that may be 
open. If no graphs are open then the View menu does 
nothing more than toggle the Tool Bar and the Status Bar 
on and off (a check mark before the Tool Bar or Status Bar 
in the menu means that it is active). If a graph is open, 
additional features appear that are related to the current 
file open. Right-clicking the mouse button on the graph to 
open a popup menu can duplicate many of the View Menu 
features. It is up to the user to decide which is the more 
comfortable method. 

9.1 Edit Parameters… (Alt+E) 

The Graph Setup Dialog Box (Fig. 44) is displayed by 
selecting Edit Parameters from the View Menu. It lets the 
user customize the look of each graph. The number of 
graphs (1, 2, or 4) as well as the contents of each graph 
are set here. 
 
At the top of the dialog box icons of five different graph 
views are shown. Select the number and format of the 
graphs by clicking on the desired view. One to four tabs 
appear corresponding to the number of graphs selected, 
and each tab marks a page for formatting the parameters 
on that particular graph. Each page is identical in appea-
rance. The numbering system of the graphs is left to right, 
top to bottom. 
 
To change a graph’s parameters, select the tab of the 
corresponding graph (if more than one graph is displayed) 
to bring up the parameter page. The page is separated in 
to two sections – plates and auxiliary devices. If any auxi-
liary devices were used, they are placed in the Auxiliary 
Device list at the right of the page and can be selected for 
viewing simply by placing a check in the box next to the 
corresponding device. 
 
A list of any plates used is in the Plates selection box. The 
list can be viewed by pressing the down arrow at the end 
of the box. Individual plates or all plates can be selected.  
Place check marks in the boxes next to the parameters to 
be viewed. The parameters are separated in to Forces, 
COP, Friction, and Moments. 
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If the COP parameter Ax vs. Ay is enabled, any other 
selected parameters will be disabled. This is because the 
x-axis is different for Ax vs. Ay. Similarly, selecting any 
other parameter will disable Ax vs. Ay if it has been 
previously enabled. 

 
The x-axis can be changed to view the data in different 
ways. Choose the x-axis view from the drop list next to the 
plate list.  The parameters are as follows: 
 Absolute Time – The default axis, displaying data as it 

was gathered without manipulation 
 Relative Time – sets time=0 at the point of first contact 

(i.e., force above the contact threshold) 
 Percent Contact – also based on the contact threshold, 

sets point of first contact at 0% and point of last 
contact as 100% 

 A/D Samples – uses the raw sample numbers for the  
x-axis 

 Frequency – converts the data from the time domain to 
the frequency domain via a Fast Fourier Transform 

 
Repeat these steps for all pages. Click OK when finished to 
close the dialog box and update the graphs, or click Cancel 
to close the box without making changes. 

9.2 Performance Parameters… 

The Graph Setup Dialog Box (Fig. 44) is displayed by selec-
ting Edit Parameters from the View Menu. It lets the user 
customize the look of each graph.   
 
The "Show Performance" button will appears in the upper 
right hand corner of the Graph Setup dialog box. 
 
Selecting the "Show Performance" button displays the 
Performance Parameters selection box (Fig. 45). The three 
orthogonal components (X, Y and Z) of 7 different perfor-
mance parameters can be selected as well as the resultant 
magnitude of each parameter. You may hide the perfor-
mance parameter dialog box by selecting the "Hide Perfor-
mance" button at any time. 
 
You may select normal BioWare parameters as well as 
Performance parameters to be displayed on the same 
graph. 
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Fig. 44: Graph Setup dialog box 

 
A list of any plates used is in the Plates drop box. The list 
can be viewed by pressing the down arrow at the end of 
the box. Individual plates or all plates can be selected. You 
cannot select all plates as one when viewing a performance 
parameter. 

Fig. 45: Performance Parameters 

 

 

If the COP parameter Ax vs. Ay is enabled, any other 
selected parameters will be disabled. This is because the 
x-axis is different for Ax vs. Ay. Similarly, selecting any 
other parameter will disable Ax vs. Ay if it had been 
previously enabled. 
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9.2.1 Notes on Performance Calculations 

9.2.1.1 Calculation of Resultant Values 

The resultant |R| component is the magnitude of the vector 
comprising the three orthogonal components, X, Y, and Z. 
The magnitude is computed using: 
 

  
 

9.2.1.2 Numerical Integration 

The calculation of velocity, displacement, power, impulse, 
and work require numerical integration to be performed on 
the force data. Numerical integration for BioWare Power 
uses Simpson’s rule because it represents a reasonable 
balance between accuracy and simplicity. Simpson’s rule is: 
 

  

 
The accuracy of the integration depends primarily on 
successfully choosing the initial condition, . The user 
must determine initial conditions.  Initial conditions highly 
depend on the peculiarities of the test being performed. It 
is imperative that the user understands the basic equations 
and the physical phenomena for the test being performed 
in order that the initial conditions can be chosen properly.  
Chapter 8.13 discusses the meaning of the initial conditions 
in more detail and provides a simple example to help aid in 
the understanding the underlying equations. 

9.2.2 Acceleration 

Acceleration Graphs: The Acceleration choice in the Perfor-
mance Parameters dialog box allows the display of accelera-
tion of center of mass data in graphical form. Acceleration, 

, is computed from the force data, body mass information, 
and static acceleration using Newtons equation . 
The vertical acceleration needs to be compensated by the 
static gravitational acceleration, , where  
m/s2. The static accelerations for all three components can 
be entered in the Setup:Initial Conditions... dialog box. 
Generally, the static Y acceleration is 9.81 m/s2, while the 
static X, and Z accelerations are zero.  Provisions are given to 
enter static X, Y, and Z accelerations to accommodate 
special setups and actions. 
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Body mass and static accelerations are entered in the 
Initial Conditions… dialog box. See chapter 8.13 for 
more information on entering the initial conditions. 

 
 
Fig. 46 shows the vertical force vs. time for an example 
force "jump" trial. With the proper body mass entered and 
earth’s gravitational acceleration removed, the resulting 
acceleration of center of mass can be computed, shown in  
Fig. 47. 
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Fig. 46: Force vs. Time 

 

Fig. 47: Acceleration vs. Time 

 

9.2.3 Velocity 

Velocity Graphs: The Velocity choice in the Performance 
Parameters dialog box allows the display of velocity of 
center of mass data in graphical form. Velocity is computed 
from the force data, body mass information, static acce-
leration, and initial velocity by first calculating the accele-
ration and then performing integration.  
The velocity, , computation is based on acceleration being 
the rate of change of velocity.  Solving for velocity yields: 

v
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The equations used for velocity are: 

 

 

 

See chapter 8.13 for more information on entering the 
initial conditions. 

 
 
 
Fig. 48 shows an example vertical velocity of center of 
mass graph from a "jump" trial. 
 

Fig. 48: Velocity vs. Time 
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9.2.4 Displacement 

Displacement Graphs: The Displacement choice in the 
Performance Parameters dialog box allows the display of 
displacement of center of mass data in graphical form. 
Displacement of center of mass is computed from the velo-
city data and initial displacement by performing integra-
tion. The displacement, , computation is based on velo-
city being the rate of change of displacement. Solving for 
displacement yields: 

 
 
The equations used for displacements are: 

 
 

 

See chapter 8.13 for more information on entering the 
initial conditions. 

 
 

 

 

Fig. 49 shows an example vertical displacement of center 
of mass graph from a "jump" trial. 
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Fig. 49: Displacement vs. Time 

9.2.5 Power 

Power Graphs: The Power choice in the Performance 
Parameters dialog box allows the display of power data in 
graphical form. Power, , is computed from the force data 
and velocity data. The equations used for power calcula-
tions are: 
 

 
 
Fig. 50 shows the vertical power graph from an example 
"jump" trial. 
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Fig. 50: Power vs. Time 

9.2.6 Impulse 

Impulse Graphs:  The Impulse choice in the Performance 
Parameters dialog box allows the display of impulse data in 
graphical form. Impulse, , is computed from the body 
mass and velocity data. The equations used for impulse 
calculations are: 
 

 
 
Fig. 51 shows an example vertical impulse graph from a 
"jump" trial. 
 

p

   
   
   
       

p t m v t p

p t m v t m

p t m v t v

p t p t p t p t

X X

Y Y

Z Z

X Y Z

 

 

 

  

                           where:   =  Impulse

                                         =  Body Mass

                                          =  Velocity

2 2 2



The View Menu 

2812A_002-312e-02.12  Page 73 

Fig. 51: Impulse vs. Time 

9.2.7 Work 

Work Graphs: The Work choice in the Performance 
Parameters dialog box allows the display of work (or often 
referred to as Kinetic Energy) data in graphical form. Work, 

, is computed from the Power data. The equations used 
for work calculations are: 
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Fig. 52 shows an example vertical work graph from a 
"jump" trial. 
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Fig. 52: Work vs. Time 

9.2.8 dF/dt (Force Gradient) 

Force Gradient, dF/dt Graphs: The dF/dt choice in the 
Performance Parameters dialog box allows the display of 
force gradient data in graphical form. Force gradient, 

, is computed from the force data. The equations 
used for force gradient calculations are: 
 Fig. 53 shows an example vertical force gradient (dF/dt) 

graph from a "jump" trial. 
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 Fig. 53: Vertical force Gradient 

9.3 Threshold (F5) 

There are two threshold settings, one for view and one for 
contact, available from the Threshold dialog box (Fig. 54). 
The View Threshold is the lower limit for viewing data on a 
graph, and the Contact Threshold is the lower limit for 
setting the contact area, or the area where the device 
measures a nonzero value. Both threshold values must be 
entered as greater than or equal to zero, though the abso-
lute value is considered when viewing the data (i.e. if the 
View threshold is set at 5N, then a force of –2N will not be 
shown, but a force of –7N will be shown). The units for 
the threshold are the default Force units (see section 10.2.1 
for information on units). Pressing the F5 key will also 
setup the threshold. 
 

Fig. 54: The Threshold dialog box 
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The View Threshold is often set just above the zero range, 
to eliminate noise data from cluttering up the graph. If the 
threshold is zero, then all gathered data points are shown 
without exception. 
 
The Contact Threshold is used to determine the start and 
finish times for plate contact. It is useful for gait analysis 
and other studies where the data is sometimes viewed with 
"% contact" as the time units. The contact threshold 
should be set just above the noise range (i.e., just above 
zero). Data above this threshold is considered to be "in 
contact" with the device. The actual contact times can be 
edited for greater accuracy at a later time (see section 8.6 
on editing contact times). 

9.4 3D View 

The 3D view allows the viewing of data as 3D vectors 
using DirectX 7. The computer you are using must support 
Microsoft DirectX7 and hardware video acceleration.  If the 
drivers for DirectX 7 are not installed this menu choice will 
be disabled. 
 
See chapter 11.6 for information more information on 3D 
view. The static playback of 3D vectors is identical to the 
realtime acquisition implementation, available under the 
Tools menu. 

9.5 View Configuration 

9.5.1 Default View… 

The user can specify his/her own default graph configu-
ration, or use the BioWare default each time. The user must 
have previously saved a configuration file prior to using it 
as default. To choose a configuration file to use when loa-
ding a graph, select View Configuration… from the Setup 
menu to bring up the Select View Configuration File dialog 
box. Place a check in the box to use the BioWare default 
configuration, or remove the check to enable the Default 
View Configuration field. Press the Select button and select 
the file from the browse box, and click Open. Press OK 
when finished. 



The View Menu 

2812A_002-312e-02.12  Page 77 

9.5.2 Load… (F8) 

View configurations can be recalled by choosing this menu 
item. A dialog box pops up (Fig. 54) with a list of any 
stored configurations. The extension for view configuration 
files is "vcf". View configurations can be stored by using 
the Save Configuration File… command (see the next 
section). Default configuration files can be set from the 
Setup  Default Graph  Default View… or View  
View Configuration  Default View  menu. 

9.5.3 Save… 

Use this command to store the current configuration to a 
file. Be sure that the graphs are set to your specifications 
before executing this command. A dialog box pops up 
(Figure 9.3) asking for the name and location to store the 
file. View Configuration files have the "vcf" extension. To 
use the configuration as default, see chapter 9.5.2 above. 

9.6 Zoom Out (F2) 

If a graph has been zoomed for a closer view of a particular 
area of data, this feature restores the graph to its full view.  
It is disabled if no zoom has been performed.  Pressing the 
F2 function key also performs the Zoom Out function.   
 
Dragging the zoom box down to the left during a right 
mouse zoom will also perform zoom out. 

9.7 Statistics (F3) 

Basic statistical analysis can be done to graphed data by 
pressing the F3 function key or by selecting Statistics from 
the Data menu. A dialog box (Fig. 56) pops up containing 
statistics for each parameter in the associated graph. The 
time period can be changed by manipulating the cursors on 
the graph (Fig. 55) and placing them at the desired start 
(green cursor) and stop (red cursor) times. To move the 
cursors simply click on the graph and hold down the mouse 
button and drag the cursor to the desired position. The 
Start or End time in the dialog box changes as its corres-
ponding cursor is moved to reflect the current position of 
the cursor. The start and end times can also be directly 
entered into their respective boxes, and the cursor will 
move to the new time specified by the box once focus is 
shifted away from it. 
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Selecting the graph and using the numeric pad left and 
right arrows will move the start time cursor one sample to 
the left and right respectively. Similarly, the numeric pad 
down and up arrows will move the end time cursor one 
sample to the left and right respectively. 
 
The statistics table can be saved to a file by entering a 
filename into the "File" box and clicking the Save button.  
The current default path is used to store the file.  To select 
a different path, click the button immediately to the right 
of the File name box ( ). A new box pops up where you 
can specify the path and filename. Click Open to accept 
the settings and return to the Statistics box, then click the 
Save button. The file is saved in tab-delimited text (*.txt) 
format. The same file can be saved again and again, with 
the newest statistics being appended to the end of the file.   
Click "Done" or press the F3 key when finished using the 
statistics to close the box. 

Fig. 55: The red and green cursors can be moved to set 
new start and end time for the statistics, respec-
tively 

 

Fig. 56: The statistics dialog box updates automatically as 
the start and end times are changed 
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9.8 Moving Cursor (F4) 

The Moving Cursor function allows a quick view of the 
graph parameters at any given time. Press the F4 key of 
choose "Moving Cursor" from the Data menu, and a 
dialog box pops up (Fig. 58) with the parameters shown on 
the associated graph. A green cursor shows up on the 
graph (Fig. 57) that can be dragged along the time axis, 
while the dialog box updates the current time reflected by 
the cursor position, as well as the parameter values at that 
time. Click F4 or the "Done" button a second time to close 
the box. 
 
Selecting the graph and using the numeric pad left and 
right arrows will move the cursor one sample to the left 
and right respectively. 

Fig. 57: The moving cursor dialog box 

Fig. 58: Move the cursor along the graph to see the corres-
ponding data values 

9.9 Copy Page (Ctrl+C) 

Use this command to save a copy of the current graph to 
the clipboard for pasting into other documents. This is a 
handy feature when creating technical papers or reports on 
your data. You can customize the graph to your liking and 
then paste it directly into your document. 
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9.10 Tool Bar 

The tool bar, along with the status bar, can be toggled on 
and off by selecting it from the View menu. A check mark 
in the left column means the tool bar is active. The toolbar 
items and their functions are listed below: 
 

  Open File.   
Brings up a dialog box to select a stored data file 
for viewing. 

  Save.   
Saves the current file and any changes made to 
the data. 

  Print.   
Opens Print dialog box to set up and print the 
current graph. 

  Copy.   
Same as the ViewCopy Page command, saves 
a copy of the current graph to the clipboard. 

  Acquire Data.   
Opens the Acquire Data dialog box. 

  Acquire Direct.  
Begins data acquisition using current settings.  
Bypasses the Acquire Data dialog box. 

  Devices. 
Opens the Device Manager to configure or add 
new devices. 

  Edit Parameters. 
Same as the View Edit Parameters command, 
opens the Graph Setup box. 

  Automatic Reset / Operate control. 
Sets Reset / Operate control to occur 
automatically when data acquisition begins and 
ends.. 

  Operate Mode 
Manually places plates in Operate mode and 
reads base line offsets if Auto Offsets are 
enabled. 

  Reset Mode. 
Manually places plates in reset mode. 
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  Zoom In.   
Rescales a graph to a new size. 

  Zoom Out.  
Restores a zoomed graph to its original full size. 
 

  Tile Horizontally.   
Places all graphs one above the other on screen. 

   Tile Vertically.  
Places all graphs side by side on screen. 

  Cascade.   
Organizes graphs in cascading format, showing 
all graph title bars with active graph on top. 

  Help. 
Opens the Help dialog box with a list of help 
topics. Same function as pressing the F1 key. 

9.11 Status Bar 

The status bar runs along the lower edge of the BioWare 

screen. It is separated into four sections. The left side of the 
status bar offers information on a topic selected when the 
mouse is moved over a menu bar or tool bar item. The 
other three sections are located on the right side of the 
status bar. The first of these shows the coordinate system 
currently being employed, either Kistler or ISB. The next 
one shows the letters CAPS if the Caps Lock key is pressed.  
The last section shows the letters NUM if the Num Lock 
key is toggled on. 
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10. The Setup Menu 

10.1 Current Graph 

The parameters for the current graph will be changed to 
the newly selected settings. Only the current graph chan-
ges, this does not affect any default settings. Newly 
created graphs will revert to the default settings. 

10.1.1 Units… 

The default units of measure used for graphing are selected 
from the Units dialog box (Fig. 60) in the Setup menu. 
Choose the desired units from each list for the corres-
ponding parameter, and click OK when finished to save 
any changes. Click Cancel to close the box without saving 
any changes. To use the Système Internationale d’Unites 
(SI) units as a global default, click the "SI Units" button 
and the default SI units will be set for each type. A table of 
all units follows, with the SI units in boldface: 
 
Parameter Unit Full Name 
Force N Newton 
 lbf pound (force) 
 kgf kilogram (force) 
 %bw percent body weight 
Length m meter 
 cm centimeter 
 mm millimeter 
 ft foot 
 in inch 
 normalized normalized 
Moment N·m newton – meter 
 N·cm newton – centimeter 
 N·mm newton – millimeter 
 lbf·ft pound – foot 
 lbf·in pound – inch 
Acceleration m/s/s meters/s/s 
 g 1 gravitational constant 
 cm/s/s centimeterss/s 
 mm/s/s millimeters/s/s 
 ft/s/s feet/s/s  
 in/s/s inch/s/s 
 norm/s/s normalized/s/s  

  
Fig. 59: Unit selections 
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Velocity m/s meters per second 
 cm/s centimeters per second 
 mm/s millimeters per second 
 ft/s feet per second 
 in/s inches per second 
 km/h kilometers per hour 
 mi/h miles per hour 
 norm/s normalized per second 
Mass kg kilogram mass 
 lbm pound mass 
Work J Joules 
 J/kg Watts/kg  (normalized) 
Power W Watts 
 W/kg Joules/kg  (normalized) 

10.1.2 Scaling… 

Graph scaling can either be automatic or manual. Auto-
matic scaling means that BioWare will choose a set of axes 
that encompass the full range of data. Manual scaling 
allows the user to set the minimum and/or maximum 
value(s) for either axis. Place a check in the appropriate 
box in the Scaling dialog box (Fig. 60) for automatic 
scaling. Press the "Autoscale Both Axes" button and 
checks is placed in all boxes. If an axis is to be autoscaled, 
the box next to it is disabled.  When manually scaling (i.e., 
box not checked), the max/min value should be entered in 
this box. For example, to force the minimum y value to 
zero, do not place a check in the box and enter 0 (zero) in 
the box.  Press OK to close the box and save changes, or 
Cancel to close without saving. 
 

Fig. 60: The scaling dialog box 
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10.1.3 Legends 

Legends can be turned on and off by choosing Legends in 
the Setup menu. Each time it is selected, a check is either 
placed next to, or removed from, the word Legends.  
When a check is present the legends will be shown on the 
graph, and when it is absent then no legends are shown. 

10.1.4 Right Mouse Zoom 

This option, when selected, allows the user to zoom an 
area of the graph. This is accomplished by clicking and 
holding down the right mouse button and dragging a box 
around the desired zoom area, and then releasing the right 
mouse button.  The Zoom option is active when a check is 
next to the words Right Mouse Zoom. To activate/ 
deactivate the option, select it from the Setup menu. See 
Fig. 61 and Fig. 62 for an illustration. 
 
Dragging the zoom box down to the right during a right 
mouse zoom or dragging the zoom box up to the left 
during a right mouse zoom will perform zoom in. 
 
Dragging the zoom box down to the left during a right 
mouse zoom will perform zoom out.  Also, pressing F2 will 
perform a zoom out. 

Fig. 61: To zoom, drag a box around the region, and 
release the right mouse button… 

Fig. 62: …and the area inside the box now fills the entire 
graph region 
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When "zoomed in", left clicking on a graph and dragging 
will scroll the graph in the direction of the mouse move-
ment. 

10.1.5 Grids 

The gridlines on the graphs in BioWare are fully customi-
zable.  Major and minor grids can be turned on or off, and 
their line style, thickness, and color can be user-defined. To 
customize the grids, choose Grids… from the Setup menu, 
and the Grids dialog box (Fig. 68) pops up. Place a check in 
the boxes where you want to see gridlines on the graphs, 
and leave the boxes blank where you do not wish to see 
gridlines. To change the look of the gridlines, click the 
"Customize Grids" button. A second dialog box pops up 
(Fig. 69) where you can choose the look of major and 
minor grids. The lists for choosing line type, width, and 
color are seen by pressing the arrow at the right side of 
each box. Press OK in the dialog boxes when finished to 
save the changes, or press Cancel to close the boxes 
without making any changes. 

Fig. 63: Gridlines can be customized for style, thickness 
and color 

10.1.6 Titles 

Selecting titles allows customization of the X axis, Y axis 
and Graph main title. The user may also edit these items by 
double-clicking the items on the graph. If a item does not 
appear on the graph, double clicking on the area where the 
item would normally appear will bring up the Graph titles 
dialog box. 

Fig. 64: Edit Graph Titles 
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10.2 Default Graph 

The parameters for the default graph will be changed to 
the newly selected settings. A graphs subsequently created 
will display the default settings. This will not effect any of 
the graphs currently being displayed. 

10.2.1 Units… 

See chapter 10.1.1 for information on selecting default 
units. 

10.2.2 Scaling… 

See chapter 10.1.2 for information on selecting default 
scaling options. 

10.2.3 Legends 

See chapter 10.1.3 for information on selecting default 
legends. 

10.2.4 Right Mouse Zoom 

See chapter 10.1.4 for information on selecting right 
mouse zooming options. 

10.2.5 Grids 

See chapter 10.1.5 for information on selecting default 
grids. 

10.2.6 Default View 

See chapter 9.5 for information on selecting and saving a 
default view. 
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10.3 Global Settings 

The globals settings choices will cause modifications to 
program settings which may include currently open graphs, 
and all graphs subsequently created. 

10.3.1 Acquisition 

See chapter 8.2 for information on setting global acquisi-
tion parameters. 

10.3.2 Coordinate System 

There are two coordinate systems supported by BioWare, 
the Kistler Coordinate System and the International Society 
of Biomechanics (ISB) Coordinate System. They are shown, 
and can be selected, in the Coordinate System dialog box 
(Fig. 65). The Kistler coordinate system is oriented to show 
the force as it was applied to a plate while the ISB system is 
reactionary, meaning that it shows the forces as the plate 
reacts to the force applied. Choosing one coordinate sys-
tem over the other is the user’s preference, and does not 
affect the data in any way. Hence, the coordinate system 
can be changes at any time and the graph will reflect the 
currently selected coordinate system.  Note that the y-axis 
in Kistler coordinates and the x-axis in ISB coordinate 
system both point in the direction of forward movement. 

Fig. 65: The Coordinate System dialog box 

 
 

10.3.3 Filters 

See chapter 10.3.3 for information on filters. 
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10.3.4 Fonts 

The Fonts dialog box (Fig. 66) lets the user change the size, 
color, and style of the graph fonts. To change a specific 
graph title or label, first choose it’s name from the list 
labeled "Adjust the font of…" and then customize it as 
desired using the available options; style, color, size.  Place 
a check in the appropriate box to make the font boldface, 
italicized, or underlined. The Font Style list is unique to 
each user’s computer, as this list is filled from the Fonts 
folder located in the user’s Windows® directory. Click OK 
to accept any changes made and close the dialog box, or 
click Cancel to close the dialog box without making any 
changes.   

Fig. 66: The Fonts dialog box 

10.3.5 FFT 

Fast Fourier Transforms (FFT’s) transform the data set from 
the time domain to the frequency domain. The FFT Setup 
dialog box (Figure 10.8) lets the user specify the window 
function and the data set length for Fast Fourier Trans-
forms. Refer to Fig. 67 for the explanation of different 
window types.  The length of the data must be a power of 
2 to perform a FFT, so it is usually necessary to manually 
adjust the length of the set. This can be accomplished by 
either truncating the data back to the nearest power of 2, 
or by adding zeroes to the set until it reaches the next 
power of 2. A good rule of thumb to use when deciding 
which adjustment to use is to calculate the length of the 
data set and figure out the nearest power of 2, and either 
truncate or pad with zeroes to get there. 
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When performing an FFT analysis the algorithm assumes 
that the data is a continuous periodic data set, meaning 
that the beginning and end points of the data set match.  
Since this is not the case most times, a "window" is applied 
to the data, multiplying the data by a half-sine wave, thus 
making the endpoints both zero and therefore a match. 
The price for this is that the magnitude of the frequency 
components is altered. The window functions in Fig. 67 are 
shown in the order of least magnitude distortion to most. 
 

Fig. 67: The FFT Setup dialog box 
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Window 
Type 

Equation Time Graph 

Rectangle A = 1 t = 0 to T

 

Cosine Bell A = 0.5 (1 - cos(25t/T)) 
A = 1 

t = 0 to T/10 and t = 9t/T to T
t = T/10 to 9T/10  

Half Sine A = sin(20.5t/T) t = 0 to T

 

Triangular A = 2t/T  
A = 2 - 2t/T  

t = 0 to T/2
t = T/2 to T  

Hanning A = 0.5 (1 - cos(2t/T)) t = 0 to T

 

Half Sine3 A = (sin(20.5t/T))3 t = 0 to T

 

Hamming A = 0.08 + 0.46(1-cos(2t/T)) t = 0 to T

 

Cosine4 A = (0.5 (1-cos(2t/T)))2 t = 0 to T

 

Parzen A = 1 - 6 (2t/T - 1)2 + 6 (2t/T - 1)3 
A = 2 (1 - (2t/T - 1))2 

t = T/4 to 3T/4
t = 0 to T/4 and t = 3T/4 to T 

 

Fig. 68: FFT Windows® Types, in the order of least magni-
tude distortion to most. 

10.3.6 Lines, Colors… 

This allows the user to customize the graphs for up to  
22 auxiliary channels and parameters for up to 6 force 
plates. Fig. 70 shows the Lines and Colors dialog box, 
which contains 7 pages separated by tabs. The first page is 
for the auxiliary devices, and the remaining are for force 
plate parameters. To change a line style or color, click the 
label for that parameter to pop up the Customize Lines 
dialog box. Choose the desired look from the drop boxes – 
the boxes drop by clicking the arrow at the right side of a 
box to expose a list – and click OK to set. Click Cancel to 
close the dialog box without making any changes. 
 
An option to configure the line styles and colors for the 
Performance parameters is included.  For each force plate 
tab, select Normal Parameters to set the line styles for the 
force and center of pressure parameters, and select the 
Performance Parameters button to set the line styles for 
the performance parameters. 
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Keep in mind when setting the lines and colors that the 
background is off-white, so lighter colors may not 
show up well. Also remember that too thick of a line 
can interfere with other data when more than one data 
set is plotted on a graph. 

 
To restore the factory default settings at any time, click the 
"Restore Global Defaults" button. This restores defaults for 
every page, not just the current page. 

Fig. 69: The default lines and colors are customized from 
this dialog box 

Fig. 70: The line color, thickness and styles are chosen from 
the lists in this box 

10.3.7 Threshold 

See chapter 9.3 for information on setting a view thres-
hold. 
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10.4 Hardware 

10.4.1 A/D Board… 

This is a shortcut to the configuration dialog box for your 
data acquisition board. Typically, once the board is installed 
there is little need to access this setup routine except to 
check the settings or change the acquisition mode. Refer to 
chapter 4.3 for information on setup of the A/D board. 

10.4.2 Amplifiers… 

The Amplifier Setup dialog box (Fig. 71), available from the 
Setup menu, is for installing and configuring amplifiers and 
for removing amplifiers from the database. When an 
acquisition device – force plate, accelerometer, EMG, etc. – 
is deleted from the database via the Device Setup dialog 
box, any associated amplifier is not deleted along with it 
because that amplifier may be configured with one or more 
other devices besides the deleted one.  An amplifier can be 
used with more than one device (provided they are both 
not active at the same time), but a device cannot be used 
with more than one amplifier. However, if an acquisition 
device is deleted and the amplifier was only used with that 
particular device, then the user may want to delete the 
amplifier as well. 
 

Fig. 71: The Amplifier Setup dialog box 
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To delete an amplifier from the database, select its name 
from the drop box and click the Remove button. If the 
amplifier Is not configured with any installed acquisition 
device then it will disappear from the database. If it is part 
of a configured device, then a dialog box will pop up 
telling you which device the amplifier is needed for, and 
will not allow the deletion until the acquisition device is 
first deleted. 
 
To add a new amplifier to the database, type the name in 
to the Amplifier Name list, and use the Tab key or the 
mouse to move the cursor to the Serial Number box.  
Notice that the ranges all reset to zero when this happens.  
Enter in the amplifier’s serial number, and use the mouse or 
Tab key to move through the boxes while entering the 
ranges and turning the time constant on or off. Press OK 
when finished, and a box will ask you for confirmation 
before creating a new amplifier record. 
 
The Amplifier Setup dialog box also allows the user to 
verify any amplifier’s range settings, and make any chan-
ges as necessary. To change a range setting or to toggle 
the time constant on and off, first choose the amplifier 
from the list and then make the necessary edits. Press OK 
to save the changes (another confirmation box will make 
sure of your decision). Press the Cancel button to close the 
dialog box without saving any changes. 
 

10.4.3 Amplifier Gains (CTRL+G) 

The amplifier gains selection allows quick and easy selec-
tion of the available amplifier gains. This applies to strain 
gage amplifiers only. If no strain-gage plates are confi-
gured in your system, this menu option is disabled. Select 
the plate for which you wish to see the gains, then select 
the gains for each channel. 
 
Fig. 72 shows the range selection dialog box. 
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Fig. 72: Amplifier Gains Selection 

10.4.4 Amplifier Ranges (CTRL+R) 

The amplifier range selection allows quick and easy 
selection of the available amplifier ranges for piezo-electric 
force plates. Select the plate for which you wish to see the 
ranges, then select the ranges for the shear, or vertical 
directions. 
 
Ranges are displayed in Newtons and represent the maxi-
mum force per channel of the force plate.  
 
Fig. 73 shows the range selection dialog box. 
 

Fig. 73: Amplifier Range Selection 
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10.4.5 Devices… (CTRL+D) 

Device configuration is accomplished via the Device Setup 
dialog box (Fig. 74). This is a very important dialog box, 
because devices are installed, configured, and activated 
here. To install a new device, click the New… button at the 
bottom of the dialog box to start the Device Wizard, which 
will guide you through the installation process. See Chapter 
14, the Device Wizard, for more information on the Device 
Wizard. 

Fig. 74: The Device Setup dialog box, where all devices are 
installed, configured and activated 

The Device Setup dialog box is divided into two sections, 
Active Devices and System Configured Devices. Active 
devices are those that are currently connected to the 
BioWare system and are ready to acquire data. System 
configured devices are all other installed devices that are 
not currently being used for acquisition, but are ready to 
be activated when needed. There is no limit to the number 
of devices that can be installed in the system. However, 
only 16 channels are available for acquisition (up to 64 
channels on custom systems), so the active devices cannot 
exceed this limit. A device can only be present in one list 
any at any time. 
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To add a device to the Active List, select the device in the 
System Configured Devices list, and click the "Add to 
Active List" button. A box pops up asking you which 
channel to connect the device to. If no channels, or not 
enough channels, are available then a warning will be 
issued. Piezoelectric Force plates must have 8 consecutive 
open channels, and auxiliary devices normally need 1 
channel, though there are exceptions. It’s good practice to 
start at channel 1 and use consecutive channels, rather 
than choosing channels arbitrarily. 
 
It is sometimes necessary to remove a device from the 
Active List before another device can be added. To remove 
a device, highlight it in the Active List and click the 
"Remove from Active" button. The device will show up in 
the System Configured Devices list, and the channels that 
had been reserved for the device become open. 
 
A device must be in the System Configured Devices list in 
order to be deleted. To remove the device permanently, 
highlight it in the System Configured Devices list and click 
Delete. You will be prompted for confirmation before dele-
tion takes place. Once confirmed, this function cannot be 
undone. 
 
Tip: You can configure the same device several times with 
different options. For example, make one force plate 
device "Normal Range" (with the amplifier set to ranges 2, 
and 3) then make a second device "High Sensitivity" (with 
the amplifier set to ranges 1, and 1). When you wish to use 
the force plate for high sensitivity work, make the "High 
Sensitivity" plate active. When you wish to use the force 
plate for normal work, make the "Normal Range" plate 
active. All other parameters (calibration information, etc…) 
will remain the same. 
 

 

Only delete a device if you are sure you will never use 
it again. There is no limit to the number of System 
Configured Devices. If an error was made when first 
installing the device, try editing the configuration 
before deleting it permanently. 

 
To view the properties of a device, either double click on its 
name or highlight it in the list and click the Properties 
button.  
 
Click the OK button to close the dialog box. 



The Setup Menu 

2812A_002-312e-02.12  Page 97 

10.4.6 Photocell/Speed Calculation 

Using a series of two photocells a user can estimate subject 
velocity using a simple distance / time calculation. To do 
this configure each photocell as a single channel device and 
enable them in the Device Manager (CTRL+D). The select 
the Setup -> Hardware -> Photocell / Speed Calculation 
menu choice. 

Fig. 75: Photocell Speed Detection Calculation Setup 

 
In the setup dialog, select the device which is Photocell 1, 
and the device which is Photocell 2. Also, enter the mea-
sured distance between the two photocells and the 
measurement units. The speed time base can be selected as 
"per second" or "per hour". The example in Fig. 75 shows 
a setup where distance between photocells is 2.5 meters.  
The calculated speed will be shown in "m/s". 
 
The next step is to determine the normal "untriggered" 
state of the photocell. Assuming the conversion factor for 
the device was setup as 1.00 sensitivity, you can use the 
oscilloscope tool (See chapter 11)  to determine the normal 
untriggered and the triggered voltage levels. Select a 
reasonable range of values for the "untriggered" state.  In 
the example in Fig. 75, the range is –1 to 2 volts, anything 
outside this range will be considered a "triggered" photo-
cell.  The software will look for the time difference bet-
ween the first trigger occurance of photocell 1, and the 
first trigger occurance of photocell 2 (this time difference 
could be negative, resulting in a negative velocity) and 
compute the average velocity. 
 
Enabling the "Display Average Walking Speed from 
Photocell devices" will display the speed in the upper left 
corner of each time based plot. 
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11. The Tools Menu 

11.1 Body Weight 

This is a scale (Fig. 76) that reads the real time vertical 
forces from a force plate. The units of force are Newtons.  
To use the Body Weight function, have the plate unloaded 
and select Body Weight from the Tools menu. The scale 
automatically begins reading forces. Perform any weight 
measurements, then press OK or Cancel to close the dialog 
box. 

Fig. 76: Body Weight Measurement Tool 

11.2 DVM… (Digital Voltmeter) 

The Voltmeter is used to analyze the voltages seen at the 
input to the A/D board in a continuously updated nume-
rical display. It is used for troubleshooting purposes. To use 
the voltmeter, choose DVM from the Data menu to open 
the Digital Voltmeter dialog box (Fig. 77). Select the 
voltage scale (volts or millivolts).  To start the voltmeter set 
it to Operate and press the Run button. The voltages are 
continuously updated. Reset the voltmeter as necessary by 
pressing Stop, Reset, Operate, then Run.   

Fig. 77: The Digital Voltmeter is a useful troubleshooting 
tool 
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11.3 Scope… 

The Oscilloscope (Fig. 78) is another useful troubleshooting 
tool that graphically displays the voltages at the inputs to 
the A/D board. It is accessed by selecting Scope from the 
Tools menu. The oscilloscope can display the voltages in 
strip chart or oscilloscope format. Strip chart has a scrolling 
x-axis while the oscilloscope format plots from left to right 
in the display window over and over without scrolling. To 
start the oscilloscope set the amplifier to Operate, and 
press Run. To stop the scope, press the Stop button. Reset 
the amplifier if it is used for an extended period of time.  
 
The oscilloscope is configurable.  Pressing the Setup button 
opens the Oscilloscope Setup window (Fig. 79). 
. Place a check in the boxes for the channels to display on 
the scope. Select the sampling rate and the length of the x-
axis scale in seconds. Then select the minimum and 
maximum voltages for the y-axis. 

Fig. 78: The Scope window 
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Fig. 79: Scope Setup 

 

11.4 Force Meter… 

The Force Meter is a real-time data acquisition tool. Forces 
for the selected plates are display in real-time. The force 
meter can display the forces in strip chart or oscilloscope 
format. Strip chart has a scrolling x-axis while the oscillos-
cope format plots from left to right in the display window 
over and over without scrolling. To start the force meter, 
place the amplifier in operate, and press start. To stop the 
meter, press the Stop button. Reset the amplifier if it is 
used for an extended period of time. 
 
The force meter is configurable.  Pressing the Setup button 
opens the Force Meter Setup window (Fig. 80). Place a 
check in the boxes for the plates to display on the scope.  
Only force plate devices that are configured and made 
active in the Device Setup will be displayed here. Select the 
sampling rate and the length of the x-axis scale in seconds, 
and the minimum and maximum values for the y-axis.   
Force units are displayed in the units configured for default 
graphs. The user has the choice of displaying Fx, Fy, Fz, 
and resultant force Ft. 
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Fig. 80: Force Meter Setup 

 

The   button will convert the current display 
to a document for normal post processing. While only the 
force plate device(s) chosen to be displayed will show on 
the screen, All active devices configured in the system will 
be converted and stored in the document.   

11.5 Real Time COP… 

The Real time COP is a real-time center of pressure 
acquisition tool. COP for a single selected plate is display in 
real-time. The COP tool is configurable.  Pressing the Setup 
button opens the COP Meter Setup window (Fig. 81).  
Place a check in the box for the plate to display on the 
scope. Only force plate devices that are configured and 
made active in the Device Setup will be displayed here.  
Select the sampling rate and the length of time to display 
COP data for, and the minimum and maximum values for 
the both axes. COP units are displayed in the units 
configured for default graphs.  
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Fig. 81: Real Time COP setup 

 

The   button will convert the current display 
to a document for normal post processing. While only the 
force plate device chosen to be displayed will show on the 
screen, All active devices configured in the system will be 
converted and stored in the document. 

11.6 3D Scope View 

The 3D view allows the viewing of data as 3D vectors 
using DirectX 7. The computer you are using must support 
Microsoft DirectX7 and hardware video acceleration. If the 
drivers for DirectX 7 are not installed this menu choice will 
be disabled. 
 
The 3D View is a Real time 3D vector tool. Data is 
displayed in a DirectX view port showing the 3 Component 
vector for each force platform. Pressing the Setup button 
opens the Setup window. Place a check in the box for each 
plate to display on the 3D scope view. Only force plate 
devices that are configured and made active in the Device 
Setup will be displayed here. Select the sampling rate and 
the length of time to display data.  
 
To begin acquisition press the "Run" button. To end 
acquisition press the "Stop button". 
The camera height, distance, and vector length scaling can 
be set using the slider controls on the bottom of the 
screen.  The Angle, and plate position can be set using the 
"pitch" and "yaw" control in the center of the view. 
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Each vector component can be individually "scaled" to 
emphasize a particular component using the vector scaling 
slider controls. 
 
Other options are: Enable drawing the actual plate models, 
fading vectors at (time selectable), and drawing vector 
plots or COP only traces.   
 

The   button will convert the current display 
to a document for normal post processing. While only the 
force plate device chosen to be displayed will show on the 
screen, All active devices configured in the system will be 
converted and stored in the document. 
 
The statistics indicate the sampling duration and the 
DirectX update rate. 
 
 

Fig. 82: 3-D Real time Vector View 
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12. The Window Menu 

Whenever a graph is open, the Window menu appears in 
the menu bar. The Window menu is for controlling the 
position of the graphs, and is useful when many different 
graphs are open on the screen. There are three different 
commands; New, Tile Horizontal, and Tile Vertical. The 
New command opens a default view of the currently active 
graph in a separate window. If the original graph has been 
zoomed or if the parameters viewed have been changed 
from default, then the new graph will not look like an 
exact duplicate of the active graph, however, the title bar 
will show that the new graph is using the same data file. 
 
Tile Horizontal (Fig. 83) places the active graphs one on 
top of the other. If four graphs are open, then it creates a 
grid of four equally sized graphs. Tile Vertical (Fig. 84) 
places the graphs side by side. Depending on the type of 
data files being viewed, there are advantages and disad-
vantages of viewing graphs using either window format. 
 
Below the three Window commands, there is a list of all 
graphs that are open on the screen, with a check mark 
placed beside the name of the currently active graph.  
Select a different graph name from the list to make that 
window active, and the check mark will move along with 
the selection. 

12.1 Debug View 

This feature opens a window with information about the 
current trial. The main file header is followed by individual 
headers with information on each device that was used, 
along with the first ten raw data samples. This is a quick 
that adversely affect the data. These features are not 
editable in this format, but any features that can be edited 
are available from the Data menu (see chapter 8) way to 
view the settings that were used for acquisition, or to 
check if there were any errors made. 
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Fig. 83: Example of the tile Horizontal command from the 
Window menu 

 
 

Fig. 84: Example of the Tile Vertical command. The win-
dows are placed side by side. 
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13. The Help Menu 

The BioWare help menu is available by selecting Help 
Topics from the Help, or if a Dialog box is open pressing 
Help button at any time. It uses the standard Windows® 
help format.   
 
While browsing through the help topics, you may 
encounter words that are blue in color. These are called 
"hot links" which will either jump you directly to that 
specific topic when pressed. Press the Back button to 
return to the previous page read. Some of the hot links are 
to Kistler specific Web pages available only when online. 
 

Fig. 85: The list of help topics available in BioWare 
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14. The Device Wizard 

Installation of new devices is accomplished through the 
Device Wizard, which takes the user step-by-step through 
the installation process. Wizards are a series of dialog 
boxes that are tied together with "Next" and "Back" 
buttons, designed to guide the user through a series of 
steps. To begin the Device Wizard choose New from the 
Device Setup dialog box, which is available from the Setup 
menu. There are two different types of devices that can be 
installed, 8-channel force plates and auxiliary devices.  
These will be discussed separately.  

14.1 Installing 8-Channel Kistler Force Plates 

Page 1   
Start the Device Wizard by choosing New… from the 
Device Setup dialog box, which is available from the Setup 
menu. Select "8-Channel Force Plate" from Page 1 of the 
Wizard (Fig. 86) and press the Next button to move on to 
page 2 (Fig. 87). 
 

 

Fig. 86: The Device Wizard Page 1 Fig. 87: Page 2 of the Device Wizard 
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Page 2  
Choose your plate type from the list, and enter a name and 
the plate serial number. Enter a name that will help you 
identify that plate easily, in case there are more than one 
plate at your location. Some examples of names are: 
"Runway Plate 1", "Diving Platform", "Long Jump Pit", 
etc. Press the Next button to move on to Page 3 (Fig. 88). 
 
 

 

Fig. 88: Page 3 of the Device Wizard Fig. 89: Page 4 of the Device Wizard for plates 
 with integrated charge amplifiers 
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Page 3  
Enter the plate dimensions on page 3. The default dimen-
sions for your force plate type are already entered in the 
left column, and may not need editing. Compare the 
values in the Wizard with actual values sent with your 
force plate, and change if necessary. The plate orientation 
values in the right column (Alpha, dx, dy) are reserved for 
future use. After entering the dimensions, click the Next 
button. 
 

 

Use the Back and Next buttons to maneuver through 
the wizard and check settings as needed. Click Cancel 
from any page to end the setup process. 

 

Fig. 90: Amplifier selection page for plates with external 
amplifiers only 

 

Page 4   
This page will have one of two looks depending on whether 
or not the plate type has a built-in (integrated) charge 
amplifier. Fig. 89 shows the wizard page 4 for integrated 
amplifiers. The force plate sensitivities should be entered 
with mV/N as the units, taking into account both the sensor 
and charge amplifier. Fig. 91 shows page 4 for force plates 
with external amplifiers. These sensitivities are for the sen-
sors only, and use pC/N as their units. A separate page is 
needed for entering the amplifier ranges in this case  
(Page 5). The Kistler coordinate system is referenced here.  
Default values for your force plate are already entered for 
either case, but will need editing because every force plate 
has unique sensitivities. Enter the sensitivity values that were 
sent with your force plate. Click the Next Button to 
continue. 
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Fig. 91: Page 4 of the Device Wizard for plates with exter-
nal charge amplifiers 

Page 5   
If the system has an external amplifier(e.g. Type 9865), 
then this is the next page in the wizard. It is skipped for 
plates with integrated amplifiers. Choose an amplifier from 
the list on page 5 (Fig. 90), or enter a new amplifier name 
in the list. Enter the plate serial number and ranges in 
pC/FSO, and click Next. 
 
Range Selection Page   
The user should select the initial per channel force range 
for both the shear and vertical directions. These ranges are 
calculated from the force plate sensitivities and amplifier 
ranges and Full Scale Output (FSO). A good rule of thumb 
is to choose the lowest range that will not be exceeded 
during the intended trials. This range selection can be 
changed as needed to handle a wide variety of applica-
tions, so it is not critical to know exactly which range to 
enter at this time. A check box is also on page 5 for ena-
bling the automatic reading of amplifier offsets prior to 
acquisition. Place a check in the box to enable this func-
tion. This is the last setup page in the wizard, and is a good 
time to go back and double check the selections up to this 
point. When ready, click Next to go to the finishing page 
of the wizard. 
 
Finish Page   
The setup is complete. All that remains is to choose 
whether to place this device in the Active list or not. To 
activate the device now, choose Yes and click the Finish 
button. A box pops up asking which channels to connect 
the device to. Choose the correct start channel and click 
OK.  If the device cannot be made active for any reason, it 
is placed in the System Configured Devices list in the 
Device Setup dialog box, where it can be made active at a 
later time. To cancel the setup process, click the Cancel 
button and the entire process is ended. 
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14.2 Installing 6-Channel Strain-Gage Force Plates 

Page 1  
Start the Device Wizard by choosing New… from the 
Device Setup dialog box, which is available from the Setup 
menu. Select "6-Channel Strain Gage Force Plate" from 
Page 1 of the Wizard (Fig. 92) and press the Next button 
to move on to page 2 (Fig. 93). 
 
 

Fig. 92: The Device Wizard Page 1 

 
 
 
 
 
 
 
 
 

Fig. 93: Page 2 of the Device Wizard 

 



 BioWare® Software Type 2812A… 

Page 112  2812A_002-312e-02.12 

Page 2   
Choose your plate type from the list, and enter a name and 
the plate serial number. Enter a name that will help you 
identify that plate easily, in case there are more than one 
plate at your location. Some examples of names are: 
"Runway Plate 1", "Diving Platform", "Long Jump Pit", 
etc.  Press the Next button to move on to Page 3 (Fig. 94). 
 
 

Fig. 94: Page 3 of the Device Wizard  Fig. 95: Page 4 of the Device Wizard for strain 
  gage plates. The calibration matrix. 

 
Page 3   
Enter the plate dimensions on page 3. The default dimen-
sions for your force plate type are already entered in the 
left column, and may not need editing. Compare the 
values in the Wizard with actual values sent with your 
force plate, and change if necessary. The plate orientation 
values in the right column (Alpha, dx, dy) are reserved for 
future use. After entering the dimensions, click the Next 
button. 
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Page 4   
The calibration matrix for the force plate is entered on page 4. 
Refer to the calibration sheet supplied with  your platform for 
the 36 values that should be entered here. Fig. 96 shows and 
example calibration matrix. Every force plate has unique 
sensitivities. Click the Next Button to continue. 
 

Fig. 96: Amplifier Selection Fig. 97: Amplifier setup page for strain gage plates  
  with external amplifiers 

 
Page 5   
If the system has an external amplifier then this is the next 
page in the wizard. Choose an amplifier from the list or 
select "Add New" to create a new amplifier. 
 
Page 6   
Fig. Fig. 98 shows the amplifier configuration page. Select 
the number of gains available for the amplifier and the 
gains values for each of the choices. 
 
Page 7  
Select the desired gains for each of the 6 channels. These 
gains must be the same as the switch settings on the front 
of the amplifier. 
 
Finish Page   
The setup is complete. All that remains is to choose 
whether to place this device in the Active list or not. To 
activate the device now, choose Yes and click the Finish 
button. A box pops up asking which channels to connect 
the device to. Choose the correct start channel and click 
OK. If the device cannot be made active for any reason, it 
is placed in the System Configured Devices list in the 
Device Setup dialog box, where it can be made active at a 
later time. To cancel the setup process, click the Cancel 
button and the entire process is ended. 
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14.3 Custom Device Setup 

Page 1   
Custom devices are defined as any devices other than force 
plates, that are connected into BioWare via BNC cables 
into the Type 5606A junction box. To set up a custom 
device using the Device Wizard, choose Custom Device 
from page 1 (see Fig. 92) and click the Next button. 
 
Page 2   
Choose the device type from the list on page 2 (Fig. 98), or 
type in a new device type if necessary. Give the device a 
name, and enter the serial number. Click Next to continue. 
 
Page 3   
Fig. 100 shows page 3 of the custom device setup process. 
Choose the units that the custom device uses, and enter 
the device sensitivity in (Volts/Device Units). If you would 
like the system to read the voltage offsets immediately 
prior to acquisition, then place a check in the check box. 
This is the last setup page in the wizard, so it is a good time 
to go back and check the settings. Click Next when ready 
to go to the finish page. 
 
Finish Page   
The setup of the custom device is complete. Choose Yes to 
make the device active and then choose the channel to 
connect the device to, or choose No to place the device in 
the System Configured Devices list. Click the Finish button 
and the Wizard box closes, and the device appears in one 
of the two lists. Click Cancel to end the setup process 
without installing advice. 

Fig. 98: Page 2 of the Device Wizard for custom Fig. 99: Page 3 of the Device Wizard for custom 
  devices  devices 
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14.4 Auto Offsets 

Each configured devices has an option to Read zero offsets 
from amplifier. When enabled (check box is checked), 
BioWare will read a base-line voltage reading for each 
channel of the device immediately after the device is 
placed into Operate mode.   
 

At the end of each data acquisition period these offsets are then subtracted from the data set. 

14.5 Reset / Operate Control 

BioWare has the option to automatically or manually 
control the Reset or Operate state of attached devices. 
 
The Reset/Operate controls are available only on the 
toolbar.  The controls are: 
 

  Automatic Reset / Operate control. 
Sets Reset/Operate control to occur auto-
matically when data acquisition begins and ends. 

  Operate Mode 
Manually places plates in Operate mode and 
reads base line offsets if Auto Offsets are 
enabled. 

  Reset Mode. 
Manually places plates in reset mode. 

 
In Automatic mode the force plates will automatically enter 
operate state and devices with Auto Zero enabled will have 
the baseline offsets read at the start of any data 
acquisition. The current state can be overridden using the 
reset and operate button but the next normal transition will 
return the control to the proper state. 
 
For Manual control press the operate button and the 
attached force plates (amplifies) will enter the operate state 
and any devices with Auto Zero enabled will have the 
baseline offsets read. Press the reset button to return the 
force plates to the reset state. 
  

 

 On startup, BioWare will always be in the 
Automatic control mode  

 The Manual control feature is useful when the 
subject must remain on the force plate between 
multiple trials  

 Do not keep plates in operate for a extended 
periods of time as a small amount of drift will 
appear in the signals 
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15. Graphs 

Manipulating data using graphs is simple and quick with 
BioWare. When a trial is opened a graph appears using the 
default configuration. The graphs can be edited for 
content, titles, scales, fonts, lines, and colors. A popup 
graph menu will appear when the right mouse key is 
clicked. For multiple graph configurations, this popup 
menu controls the features for the graph over which the 
mouse arrow is positioned. The features of the popup 
menu are: 
 

 

Changing the graph units, scaling, grids, titles, and 
legends from the popup menu will change the current 
graph only. Use the Setup menu to globally make 
changes. 

 
 Edit Parameters.   

The same as the Edit Parameters command from the 
View menu. See chapter 9.1 for an explanation of the 
Edit Parameters dialog box 

 Show Full Screen.   
Used for files with multiple graphs in the same window.  
When selected, the active graph is enlarged to cover 
the entire window, covering all other graphs. When 
selected again, the graph returns to its original size and 
all other graphs are seen. This is handy to take a quick 
look closer at a particular graph without having to 
change the configuration 

 Right Mouse Zoom.   
When a check is placed next to this menu item, the 
graph can be zoomed by holding down the right mouse 
button and dragging a box around the area to zoom.  
To disable zooming, remove the check 

 Zoom Out.   
If a graph is zoomed, use this menu item to restore the 
graph to its original scale. The command is disabled 
unless a graph has been zoomed. F2 also restores the 
graph 

 Legends.   
Legends are toggled on or off by placing or removing a 
check next to the Legends menu item 

 Scaling…   
Allows the user to configure the axes for automatic or 
manual scaling 

 Titles…   
The graph title and axis titles can be entered here.  
They can also be edited by double clicking the title on 
the graph directly 
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 Units… 
The units for the selected graph can be changed by 
selecting Units… from the popup menu. Changing units 
from the popup menu affects only the current graph 
and not all graphs 

 Grids.   
The grids can be enable or disabled by selecting the 
grids option. Major and minor grids can be selected fro 
the grids dialog box then pressing OK 

 Copy Graph.   
The current graph is copied to the clipboard for pasting 
into other documents. If more than one graph is confi-
gured in the window, only the graph under the mouse 
arrow is copied. To copy all graphs in such cases it is 
necessary to choose Copy Page from the View menu 

 Print.   
Prints out a copy of the entire graph. The Print dialog 
box first appears allowing for changes to the printer 
setup, pressing OK will start the printing. The printout 
includes all graphs in a single window, not just the 
current graph 

 
To get information on a specific data set on a graph, 
double click the mouse directly on the desired curve. A box 
will pop up with information about the data set. The data 
itself can be viewed by clicking the View Data button from 
this box. This is helpful when a graph has multiple data sets 
that can make it difficult to tell one set from another. 
 

 

To see which trial a data set is associated with, double 
click the curve in the graph. An box will appear with 
information on the data set, along with a button that 
you can press to see the data values directly. 

 
Similarly, the graph appearance can be directly edited by 
double clicking the mouse on a graph feature. For exam-
ple, the scale of a graph can be edited by double clicking 
along an axis. Doing this opens the Scaling dialog box 
where auto scaling can be toggled on and off, and where 
minimums and maximums can be set. 
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16. Tutorials 

16.1 Installing a Force Plate with the Device Wizard 

The following tutorial will demonstrate how to use the 
Device Wizard to install and configure a Kistler force plate.  
The plate in this example is a portable Type 9286 with an 
external Type 9865… charge amplifier. This tutorial assu-
mes that the data acquisition board has been configured 
and the plate and amplifier are connected to the system.  
Follow along with the steps and feel free to substitute your 
own force plate for the example. 
 
 Launch BioWare and select Devices from the Setup 

menu, or press the  button in the toolbar to open 
the Device Setup dialog box (see Fig. 101). Ctrl+D also 
accomplishes this. 

 Press New… to start the Device Wizard 

 Select "8-Channel Force Plate" and press the Next 
button 

 From the drop list, select "9286". Enter the name 
"Tutorial" and the serial number "123456". This will 
make it easy to identify and remove later.  Remember 
that you can substitute your own force plate for the 
example.  Press the Next button when finished 

 The plate dimensions and orientation are acceptable as 
is. We can go on to the next page by pressing Next 

 If you are installing an actual force plate, enter your 
force plate sensitivities from the literature that was 
shipped with the plate. For this example, we can leave 
the sensitivity values as they are. Move on to page 5 by 
pressing the Next key 

 Enter the amplifier name as "test 9865". Press the Tab 
key and notice that the fields all go blank, as BioWare 

senses a new amplifier is being installed. Use the tab 
key or the mouse to move around and edit the other 
fields. Enter "4321" for the serial number. Use the 
values 1 000, 5 000, 10 000, and 50 000 for ranges  
1 to 4, respectively for both xy and z. Press Next to 
move on, and click "Yes" when prompted to create the 
new amplifier in the database 

 Page 6 is the Range Selection page. Select a shear 
range of 641 and a vertical range of 1515. These values 
reflect amplifier range 2. If you are configuring your 
own plate or if you entered in different sensitivity or 
range values earlier, then these values will be different.  
Place a check in the box to correct for amplifier offsets 
if one is not already there.  Press Next to continue 

Fig. 100: Device Setup 
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 Our plate is now configured. Select "Yes" to add the 
device to the Active List (in the Device Setup box). You 
can press the Back button to verify selections on pre-
vious if you wish. When ready, press the Finish button 

 The Wizard box closes and another small box pops up 
asking us to select a channel to start the acquisition 
(Fig. 102). Channel 1 is acceptable, so we can press 
OK. The box disappears and we see our plate in the 
Active Devices list in the Device Setup dialog box. We 
are connected to channels 1 through 8. We can check 
the plate settings by highlighting the plate and pressing 
Properties. Press OK to close the dialog box 

 
This concludes the tutorial on using the Device Wizard to 
install devices. The procedure is the same for plates with 
integrated amplifiers or for auxiliary (single-channel) devi-
ces, although some of the wizard dialog boxes may 
change. To remove the plate, perform the following steps: 

 Highlight it and remove it from the Active Devices list 
by pressing the Remove form Active button 

 The device is now in the System Configured Devices 
list. Highlight it again and press the Delete button. A 
box pops up asking you to confirm the deletion. Press 
"Yes" to confirm the removal and it will disappear from 
the list 

 To remove the amplifier that was installed, close the 
Device Setup dialog box and choose Amplifiers… from 
the Setup menu 

 Select the "Test 9865" amplifier from the list and press 
the "Remove" button. If no configured plate is associa-
ted with the amplifier (as is the case here) then the 
record is eliminated. Press OK to close the box 

16.2 Standing Jump Height Calculation 

The following tutorial will demonstrate how to use the 
BioWare Performance to calculate the jump height of the 
center of mass for a standing jump. 

 Configure the force plate device per the BioWare 
manual to acquire data 

 Select Data: Acquire Trial. Set sampling rate to 250 Hz, 
and length to 4 seconds. Set trigger to "trigger on a 
key" 

 Press the "Weigh" button in the Acquire Trial dialog 
box, and measure the subjects body weight (Mass) 

 With the subject standing off of the force plate, Press 
the "Start" button. When the "Press Enter to Begin" 
message appears, have the subject stand on the force 
plate.  Instruct the subject to perform a vertical jump on 
your signal. Press the "OK" button and tell the subject 
to begin 

Fig. 101: Start channel 
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 The default graph will appear. Select View: Edit 
Parameters from the main menu. In the edit parameters 
dialog box, select "Clear All", then select a single 
graph, Fz (vertical force). Your graph should appear 
similar to Fig. 102 

 Select the Performance: Initial Conditions… menu 
choice. Press the "Calculate I.C. Average Acceleration = 
0" button, the Static Acceleration Values should be set 
to approximately 0 for the two shear components and  
1 g for the vertical component 

 Press the "Calculate I.C. Average Velocity = 0" button, 
the Initial Velocity Values should be set to approxi-
mately 0 for the two shear components and the vertical 
component. These values may not be identically zero 
because the subject’s center of mass is in continuous 
motion (balancing) even when standing "still" 

 Enter 0 for the three initial displacement values. Then 
press OK to exit the Initial Conditions dialog box 

 Select View: Edit Parameters from the main menu 
again. Press the "Show Performance" button and select 
Vertical Displacement (Z in Kistler coordinate system). 
Deselect the vertical force curve and select OK to graph 
the vertical displacement of center of mass (Fig. 103) 

 Click once on the graph then press F3 (statistics). The 
statistics dialog box will appear showing the maximum 
displacement of the center of mass. This is the desired 
jump height 

 Try selecting different initial conditions to see how it 
can affect the graph 

 End of tutorial 
 
Other suggestions: 
 Use statistics on the first portion of the jump trial (quite 

standing) to measure the average body weight. Enter 
this value in the Initial Conditions dialog box for the 
body mass 

 Try entering the know assumptions for initial condi-
tions, 0 shear accelerations, 1 g vertical acceleration of 
gravity, and zero’s for the remaining velocities and 
displacements 

 
Use the Data:Edit Contact times and set the starting 
contact time to the time when the subject leaves the plate 
and set the ending contact time to when the subject 
returns (lands) to the plate. Return to the View:Edit 
Parameters dialog and change the X axis to Percent 
Contact. Verify that peak displacement occurs near time = 
50%, and that velocity of center of mass crosses zero at 
this time. This is not necessarily a requirement of jumping, 
can you determine why? 
 
 

Fig. 102: Vertical Force Jump Trial 

Fig. 103: Displacement of center of mass 
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17. Shortcut Key Summary 

Key Command 

F1 Help 

F2 Zoom Out 

F3 Statistics 

F4 Moving Cursor 

F5 Threshold 

F8 Open / Load View Configuration File 

  

Ctrl+O Open File 

Ctrl+S Save File 

Ctrl+P Print File 

Ctrl+C Copy to Clipboard 

Ctrl+D Device Manager 

Ctrl+R Amplifier Range Selection 

  

Ctrl+TAB Cycle through Open Windows® (forwards) 

Ctrl+SHIFT+TAB Cycle through Open Windows® (backwards) 

  

Alt+A Acquire Data Direct 

Alt+E Edit Parameters (Setup Graph) 

Alt+I Initial Conditions 

  

Right Mouse Click on graph Shows Pop Menu Graph Edit Choices 

Right Mouse Drag on graph 
(down-left) 

Zoom Out (if previously zoomed in) 

Right Mouse Drag on graph 
(excluding down-left) 

Zoom In on graph 

Left Mouse Drag on graph Scroll Graph (if previously zoomed in) 
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18. Example Files 

Filename Description 

Balance Eyes Closed.dat Balance Trial (eyes closed) – 30 seconds, 100 Hz 

Balance Eyes Open.dat Balance Trial (eyes open) – 30 seconds, 100 Hz 

Ballistocardiogram.dat Ballistocardiogram – Plate set to highest sensitivity, A/D Board Gain set 
to 8X (+/-1.25 Volts).   Vertical force shows blood flow dynamics of 
heart, approximately 120 beats per minute (2 per second).  FFT show 
heart frequency at 2 Hz. 

Jump (BW Zeroed).dat Subject standing on plate, Amplifier is reset nulling body weight.  
Force’s shown are the variations from initial operate level. 

Jump.dat Amplifier is reset, set to operate, then subject stands on plate.  Force’s 
shown are the variations from including the subjects body weight. 

Left Foot.dat Single plate, left foot strike 

Right Foot.dat Single plate, right foot strike 

Run 2 Plate.dat Two plate, running trial 

Subject 000.dat Autosave trial, One plate active, left foot strike forwards direction 

Subject 001.dat Autosave trial, One plate active, right foot strike backwards direction 

Subject 002.dat Autosave trial, One plate active, left foot strike forwards direction 

Subject 003.dat Autosave trial, One plate active, right foot strike backwards direction 

Subject Merged.dat Merged file of Subject 000.dat through Subject 003.dat data files 

Sweep.dat No force plates active, Auxiliary device connected to function 
generator creating a sine wave sweep from 50 to 250 Hz.  Useful for 
testing FFT and filters. 

Walk 2 Plates (rotated).dat Two plates active, Global Coordinate system defined with plate 2 
rotated 315 degrees to the global coordinate y axis.   

Walk 2 Plates.dat Two plates active, Global Coordinate system defined. 
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